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プロトコルは予告なく変更になることがあります。プロトコルを日本語化するにあたり、作業時間が発生す

るため、日本語プロトコルは英語の最新バージョンに比べて、どうしても遅れが生じます。製品ご購入の際

は、必ず製品添付の英語版プロトコルの Version をお確かめの上、日本語版が古い場合は、最新の英語

版を参照くださるようお願い申し上げます。 

  
What’s new in v7.1 

・ Agilent SureTag Complete DNA Labeling Kit と Agilent SureTag DNA Labeling Kit に対応 

・ 2012 年 1 月作成版よりの改定：p.83 の QC metrics 表を変更 

What’s new in v7.3 

・ 取得するデータの精度のために定期的にハイブリダイゼーションオーブンを校正する内容を追加 

・ Genomic DNA Enzymatic Labeling Kit（販売終了）の内容を削除 

・ ラベル化時のランダムプライマーアニーリングと、ハイブリダイゼーション時のマスターミックスの、変性

温度を 95℃から 98℃に変更 

・ ハイブリダイゼーションの温度を 65℃から 67℃に変更 

(2011 年５月版 ラベル化 DNAQC クライテリアおよび必要なものリスト遠心濃縮装置の部分に改訂)  
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1. アレイ CGH (aCGH)実験 

 

アレイ CGH(aCGH)法は、マイクロアレイと従来の*CGH 法（Comparative Genomic Hybridization：比較ゲノ

ムハイブリダイゼーション）を組み合わせることで、ハイスループットに目的遺伝子、ゲノムＤＮＡ領域のコピー

数変化を検出する手法です。 

*CGH 法：1992 年、Kallioniemi らが、Science 誌で発表した方法です。FISH 法（Fluorescence in situ 

hybridization）を応用した方法で、全染色体を対象として、ゲノム DNA が増幅（gain）、欠失（loss）した領域

を調べる方法です。 

 

 

 

アジレントのオリゴ DNA マイクロアレイは、インクジェット技術を用いて 60mer の DNA オリゴプローブを、基

盤上に直接 in-situ 合成する方法で製造されています。In-situ 合成により、非常に均質なスポットをしかも高

密度でアレイ上に作成できるため、アレイ実験の再現性が非常に向上し、信頼性の高い結果を得ることが出

来ます。 

 

アジレント・テクノロジーでは、マイクロアレイ実験をされる実務者の方を対象に DNA マイクロアレイ カストマ

ニュースを配信しています。実験プロトコルのアップデート・新製品のご案内・実験に関するトラブルシュート・

試薬や消耗品の保存など、実験を成功させるためのテクニカルサポートに内容を限定して、E-mail でお送り

しています。受信をご希望の方は「DNA マイクロアレイ カストマニュース配信希望」と明記して、お名前・ご所

属・配信を希望する E-mail アドレスを下記宛先までお知らせください。 

 email_japan@agilent.com 

 

 

  

mailto:email_japan@agilent.com
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2. 安全に実験を行うために 

 

・ スライドグラスの縁は鋭利です。手袋をはめ、十分注意して取り扱ってください。 

・ 本実験では、毒性のある試薬を使用します。操作時の安全には、白衣、手袋、必要に応じてマスク、眼鏡

をご着用いただくなど各自で十分ご注意いただきますよう、お願い申し上げます。 

・ Cyanine 3-dUTP と Cyanine 5-dUTP は発癌性物質を含んでいる可能性があります。吸引、誤飲、皮

膚への直接の接触は避けてください。 

・ 2x HI-RPM Hybridization Buffer には塩化リチウム(LiCl)が含まれています。塩化リチウム(LiCl)には中

枢神経系への毒性があります。催奇性があり、乳児に悪影響を与える可能性があります。不妊を誘発す

る可能性があります。吸入、皮膚接触、誤飲により、害を引き起こします。必ず適切な白衣、手袋、

マスク、防護めがね等を着用してください。 

・ 2x HI-RPM Hybridization Buffer にはドデシル硫酸リチウム(LLS)が含まれています。ドデシル硫酸リチ

ウム(LLS)は毒性があり、目、気管器系、皮膚に炎症を起こす可能性があります。必ず適切な白衣、手袋、

マスク、防護めがね等を着用してください。 

・ 2x HI-RPM Hybridization Buffer には Triton が含まれています。誤飲により害を引き起こします。 

・  Agilent Stabilization and Drying Solution (cat. No. 5185-5979)は、毒性、引火性があります。必ず、

適切なヒュームフード（ドラフト）内で使用して下さい。 

・  Agilent Stabilization and Drying Solution (cat. No. 5185-5979)は有機溶媒を含んでいます。ご施設

における所定の廃棄処理を行ってください。 

 

実験上の注意 

・ 血液・細胞・凍結組織からゲノム DNA を抽出する際は、実験の成功率を上げるために本プロトコルに記

載されている方法に従ってください。FFPE サンプルを用いた実験は、Ailent Oligonulceotide Array-

Based CGH for Genomic DNA Analysis (ULS Labeling for Blood, Cells, Tissues, or FFPE) Protocol 

(p/n G4410-90020)をご参照下さい。FFPE サンプルは SurePrint G3 CGH+SNP マイクロアレイではサ

ポートいたしておりません。 

・ DNA の抽出方法をこの資料に記載されている方法に従うことが出来ない場合は、DNA に RNA やたん

ぱく質の混入がないことを確認してください。 

・ ヌクレアーゼのコンタミネーションを防ぐために、実験中はパウダーフリーの手袋を着用し、推奨の試薬お

よびヌクレアーゼフリーでエアロゾル耐性のピペットチップを使用してください。 

・ 実験作業場所を清潔に保ってください。 

・ ゲノム DNA は物理的な衝撃により破壊されやすいので、ゲノム DNA を含む溶液は、ボルテックスによる

攪拌を行わないようにして下さい。指でやさしくチューブをタッピングする混合を行って下さい。 

・ ゲノム DNA を含む液や酵素の繰り返し凍結融解を避けてください。 

・ 凍結されている試薬を使用する場合は 

1. 室温以下の温度で、できるだけすばやく試薬を溶かす 

2. ボルテクスミキサで軽く攪拌し混合し、5～10 秒の遠心で壁や蓋についた液を底に落とす 

3. 使用するまで氷上か cold block におく。 

・ 概して、バイオセーフティーレベル１（BL1）のルールに従い実施してください。 
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3．必要なものの確認 

 

【マイクロアレイ保存上の注意】 

マイクロアレイは室温で保存して下さい。マイクロアレイのフォイルの袋開封後は、マイクロアレイのスライドは

室温の暗所で、真空デシケータか窒素パージしたボックスで保管をしてください。開封後は高湿・温度変化・外

気との接触を極力避けて下さい。保管に必要な設備がない場合、全てのマイクロアレイスライドは受注製造に

よって１スライドパッケージで納品することが可能です。納期はお問い合わせください。 

 

【ラベル化の試薬の保管について】 

SureTag DNA Labeling Kit および SureTag DNA Complete DNA Labeling Kit には Cyanine 3 dUTP 色

素と Cyanine 5 dUTP 色素が含まれます。色素は到着後-20℃で保存し、溶解後は遮光 4℃で保存してくださ

い（色素の繰り返し凍結融解を避けてください。分注不可）。実験間隔があく場合は、-20℃でも保存可能です。 

 

【試薬・消耗品の保証期間について】 

アジレントマイクロアレイおよびその他のアジレント製品の保証期間は、箱やチューブの入った小袋あるいは

ボトルに記載の Expiration date(Exp. date)までです。保証期間を過ぎた製品については欠品等があった場合

も交換ができない場合がありますので、製品が納品されたらすぐに内容物を確認して下さい。 

保証期間を過ぎると性能の保証ができないため、保証期間内に使用するように計画して下さい。 

実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お問い合わせ頂く際は

これらの情報を添えて、お問い合わせ下さい。 

 

※指定：必ず指定されたものをご使用ください。指定品以外を使用された場合は保証の対象外になります。 

※相当：コメント欄に記載された条件を満たすものなら、何を使用されてもかまいません。（青文字は Agilent

製品です） 

※ULS プロトコルで必要な試薬・機器類につきましては、Ailent Oligonulceotide Array-Based CGH for 

Genomic DNA Analysis (ULS Labeling for Blood, Cells, Tissues, or FFPE) Protocol (p/n G4410-90020) 

をご参照ください。  
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消耗品（試薬など） 
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オリゴ DNA マイクロアレイキット アレイ CGH プロトコル操作実習テキスト 9 

機器・器具 

 

 

 

 

Vacuum concentrator について：MV-100[TOMY]：サンプルを Microcon チューブから Eppendorf チューブに移し替えて

行ってください（Microcon チューブ底部が遠心機内壁に接触するため）。また、長時間連続使用は、発熱することがあるので避

けてください。CC-105 [TOMY]：Solid タイプロ－タ使用時はサンプルを Microcon チューブから Eppendorf チューブに移し替

えて行ってください（もしくは Composite タイプのロ－タをご使用ください） 
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4．実験で使用する Agilent 試薬キットの確認 

 

アジレント SureTag DNA Labeling Kit 50 反応分 （x8 フォーマット 100 反応分） 

            （製品番号 5190-3400） 

Component  Volume (ul) 保存条件 

Nuclease Free water 1500 －20℃ 

Random Primers 265 －20℃ 

10 x dNTPs 265 －20℃ 

5 X Reaction Buffer 525 －20℃ 

Exo-Klenow Fragment 55 －20℃ 

10X Restriction Enzyme Buffer 130 －20℃ 

BSA 10 －20℃ 

Alu I 25 －20℃ 

Rsa I 25 －20℃ 

Cyanine3-dUTP* 75 遮光。－20℃、溶解後は4℃ 

Cyanine5-dUTP* 75 遮光。－20℃、溶解後は4℃ 

Amicon Ultra-0.5, Ultracel-30 Membrane, 30kDa 50 units 室温 

*Cyanine 3 dUTP 色素と Cyanine 5 dUTP 色素が含まれます。色素は到着後-20℃で保存し、溶解

後は遮光 4℃で保存してください（色素の繰り返し凍結融解を避けてください。分注不可）。実験間

隔があく場合は、-20℃でも保存可能です。 

 

アジレント SureTag Complete DNA Labeling Kit 50 反応分 （x8 フォーマット 100 反応分） 

            （製品番号 5190-4240） 

Component  Volume (ul) 保存条件 

Human Reference DNA (Male and Female)** 25 µg each －20℃、溶解後は4℃ 

Nuclease Free water 1500 －20℃ 

Random Primers 265 －20℃ 

10 x dNTPs 265 －20℃ 

5 X Reaction Buffer 525 －20℃ 

Exo-Klenow Fragment 55 －20℃ 

10X Restriction Enzyme Buffer 130 －20℃ 

BSA 10 －20℃ 

Alu I 25 －20℃ 

Rsa I 25 －20℃ 

Cyanine3-dUTP* 75 遮光。－20℃、溶解後は4℃ 

Cyanine5-dUTP* 75 遮光。－20℃、溶解後は4℃ 

Amicon Ultra-0.5, Ultracel-30 Membrane, 30kDa 50 units 室温 

*Cyanine 3 dUTP 色素と Cyanine 5 dUTP 色素が含まれます。色素は到着後-20℃で保存し、溶

解後は遮光 4℃で保存してください（色素の繰り返し凍結融解を避けてください。分注不可）。 

実験間隔があく場合は、-20℃でも保存可能です。 

**ゲノム DNA の繰り返し凍結融解を避けてください。（長期保存の際は分注後－20℃保存推奨） 
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アジレント Oligo aCGH/ChIP-on-chip Hybridization Kit  25 スライドグラス分 

            （製品番号 5188-5220） 

本キットは開封するまでは室温（17-23℃）で保存してください。 

Component  Volume (ul) 保存条件 

2 x Hi-RPM Hybridization Buffer 1400/vial, 5 vials 室温* 

10 X aCGH Blocking Agent 1 vial 室温、調製後は－20℃** 

* 2x Hi-RPM Hybridization Buffer を冷蔵・冷凍保存しないでください。 

** 開封して、10x aCGH Blocking Agent を調製後は、この試薬のみ-20℃で保存してください。 

 

アジレント Cot-1 Human DNA （製品番号 5190-3393） 

Component  Volume 保存条件 

Cot-1 Human DNA 625 ug ―20℃ 

 

アジレント Oligo aCGH/ChIP-on-Chip Wash Buffer Kit  （製品番号 5188-5226） 

Component Volume 保存条件 

Oligo aCGH/ChIP-on-Chip Wash Buffer 1 4L/pack, 2 packs 室温 

Oligo aCGH/ChIP-on-Chip Wash Buffer 2 4L/pack, 1 pack 室温 

※個別にご購入することが可能です。 

・Oligo aCGH/ChIP-on-Chip Wash Buffer 1（製品番号 5188-5221） 

・Oligo aCGH/ChIP-on-Chip Wash Buffer 2 （製品番号 5188-5222） 

 

アジレント Stabilization and Drying Solution  -  500 mL （オプション） （製品番号 5185-5979） 
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5．CGH マイクロアレイフォーマット（2020 年 10 月現在） 

 

アジレントの CGH マイクロアレイのフォーマットは 8 種類 

 

 1-pack 2-pack 4-pack 8-pack 

HD 1x244K 

~244,000 プローブ/

アレイ 

 

2x105K 

~105,000 プローブ/ 

アレイ 

 

4x44K 

~44,000 プローブ/ 

アレイ 

 

8x15K 

~15,000 プローブ 

/アレイ 

 

G3 1x1M 

~1,000,000 プローブ

/アレイ 

 

2x400K 

~400,000 プローブ/ 

アレイ 

 

4x180K 

~180,000 プローブ/ 

アレイ 

 

8x60K 

~60,000 プローブ/ 

アレイ 

 

     

カスタムアレイ 

1M、2x400K、4x180K、8x60K、244K、2x105K, 4x44K、8x15K フォーマット対応*  

弊社ウェブサイト Sure Design（http://www.chem-agilent.com/contents.php?id=1002474）より、Agilent デ

ザインの CGH 用および SNP 領域プローブデータベースから、研究のターゲットとする領域に、任意の分解能

でプローブを選択してカスタムアレイを作成する事が可能です。 

生物種:ヒト・マウス・ラット・ニワトリ・イヌ・ウシ・チンパンジー・アカゲザル・線虫(2020 年 10 月 現在) 

* CGH+SNP マイクロアレイは 1M、2x400K、4x180K、8x60K にのみ対応 

 

 

 マイクロアレイ保存上の注意： マイクロアレイは熱・湿気・オゾンにより劣化します。 

• アレイは室温で保存して下さい。 

• 開封後は暗所・室温で、真空デシケータ中か、窒素パージした箱の中で保管して下さい。 

• 開封後は、マイクロアレイスライドを外気にさらさないで下さい。 

 

  

244k 105k 44k
15k

1M 400k 180k
60k

http://www.chem-agilent.com/contents.php?id=1002474
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6．必要なスキャナおよびソフトウェア 

 

 スキャナ 

コントロール 

ソフトウェア 

Feature Extraction ソフトウェア 

CGH+SNP G3-CGH 

1x1M、2x400K、

4x180K、8x60K 

HD-CGH 

1x244K、2x105K、

4x44K、8x15K 

SureScan 9.1 10.10*以降 10.5 以降 10.5 以降 

C Scanner 8.3 以降 10.10*以降 10.5 以降 10.5 以降 

B Scanner 7.0.03 以降 – – 9.5 以降 

A Scanner 7.0.01 以降 – – 9.5 以降 

GenePix 4000B – – – 9.5 

*Feature Extraction ソフトウェア v10.10 は Agilent Genomic Workbench v6.5 Standard インストーラ

（64bit 対応のみ）および CytoGenomics v1.5 以降（32bit, 64bit 対応）に含まれています。 

 

※ CGH+SNP マイクロアレイの解析には、Agilent Genomic Workbench 6.5 以降または CytoGenomics 

1.5 以降が必要です。 

※ Cancer CGH+SNP マイクロアレイの解析には CytoGenomics 2.0 以降が必要です。 

 

 

解析ソフトウェア、Feature Extraction の PC システム要件などの情報は弊社ホームページをご参照下

さい。 
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7．DNA サンプルの調製 

 

アジレントのアレイ CGH アプリケーションは”２色法”を用いて、対照（reference）サンプルに対する被検査

（experimental）サンプルの DNA のコピー数変化(CNC)(CGH+SNP マイクロアレイを使用時は copy-neutral 

Loss of Heterozygosity や Uniparental Disomy)を検出します。Reference として用いるサンプルは実験内

容に依存しますが、SureTag DNA Copmplete Labeling Kit [p/n 5190-4240] に含まれる Human Reference 

DNA (Male、Female) のような市販の正常ゲノム DNA が用いられることも多いです。 

 

本チャプターでは、アジレントが推奨するゲノム DNA 調製の推奨方法（血液・細胞・凍結組織から DNeasy 

Blood & Tissue Kit を用いて、ゲノム DNA を調製する方法）が記載されています。 

 

FFPE サンプル抽出 DNA など、分解・ダメージがあるゲノム DNA を使用する場合は、別途 Agilent 

Oligonuclotide Array-Based CGH for Genomics DNA Analysis (ULS Labeling for Blood, Cells, Tissues, 

or FFPE) Protocol (p/n G4410-90020)をご参照ください。SurePrint G3 CGH+SNP マイクロアレイを使用す

る場合、FFPE サンプルはサポートいたしておりませんのでご留意ください。 

 

【CGH+SNP マイクロアレイの Reference サンプルの推奨】 

 

SurePrint G3 CGH+SNP マイクロアレイを使用する場合、reference サンプルは ”genotype された個体サン

プル” を用いる必要があります（pool DNA は不可）。以下のいずれかの DNA サンプルを reference にご使

用いただけます。 

 

1. SureTag Complete DNA Labeling Kit [p/n 5190-4240] に含まれる Human Reference DNA 

 

2. 以下５種の推奨 HapMap サンプルのうち１つ：NA18507 (Yoruba Male)・NA18517 (Yoruba Female)・

NA12891 (European Male)・NA12878 (European Female)・NA18579 (Chinese Female)。HapMap 

サンプルは Coriell Institute for Medical research からオーダー可能です。 

 

3. 上記以外の reference サンプル(single individual より調製) を genotype して使用 

方法：それぞれ上記推奨５種の Coriell DNA とハイブリし CGH+SNP マイクロアレイデータを取得 

（初めに１度だけでよい） 

 Array #1 Cy3: NA18507 Cy5: 新規 reference 

 Array #2 Cy3: NA18517 Cy5: 新規 reference 

 Array #3 Cy3: NA12891 Cy5: 新規 reference 

 Array #4 Cy3: NA12878 Cy5: 新規 reference 

 Array #5 Cy3: NA18579 Cy5: 新規 reference  

#1 から#5 の genotype のデータを 1 つにまとめて新規 reference genotype file を作成し、解析ソフトウェア

（Agilent Genomic Workbench v6.5 以降または CytoGenomics v1.5 以降）にインポートして使用 
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ラベル化反応に使用する experimental サンプルのゲノム DNA 量は、reference サンプルのゲノム DNA

量と同じにする必要があります。DNA の定量が不正確であると、ラベル化に使用する experiment と

reference の DNA 量に差が生じ、その結果アッセイノイズ（DLRSD）を増加させます。サンプルの抽出方法

が異なる場合も、定量におけるアーチファクトを生じさせることがあります。アッセイノイズを最小にとどめるた

めに、二本鎖 DNA を高く選択的に定量する蛍光分析法（例 Qubit）を用いることをアジレントは推奨いたしま

す。NanoDrop 分光計 はゲノム DNA の純度の確認に使用できます。Agilent Human Reference DNA 

Male・Female は 200 ng/μL で、分光計と蛍光光度計の両方で測定されているので、濃度を再測定する必

要はありません。 

 また、GenetiSure Cancer Research CGH+SNP 2×400K または GenetiSure Postnatal Research 

CGH+SNP 2×400K は、弊社では Agilent Human Reference DNA Male または Female でのみ検証を行

っておりますため、これらのリファレンスサンプルをご使用下さい。 
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血液・細胞・凍結組織から抽出
したExperimentalゲノムDNA

市販もしくは血液・細胞・
凍結組織から抽出した
ReferenceゲノムDNA

制限酵素によるDNA断片化* 制限酵素によるDNA断片化*

DNAのラベル化 DNAのラベル化

ラベル化DNAの精製 ラベル化DNAの精製

ハイブリダイゼーション前調製

24時間または40時間
ハイブリダイゼーション（67℃）

マイクロアレイの洗浄

マイクロアレイのスキャン

数値化（Feature Extraction）

解析（Agilent CytoGenomics または
Agilent Genomic Workbench）

* SurePrint HD・G3 CGHマイクロアレイ使用時はオプション。
SurePrint G3 CGH+SNPマイクロアレイ使用時は必須。

ダイレクト法のサンプル調製とマイクロアレイ操作

調製にはゲノムDNA 0.5μg（1-pack, 2-pack, 4-pack) または
0.2μg (8-pack) が必要です。

ダイレクト法（p.33～）のサンプル調製とマイクロアレイ操作 
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7-1．ゲノム DNA の調製 

DNeasy Blood & Tissue Kit をご使用ください。 

注： DNeasy Mini Spin Column と溶出液が接触するのを避けるために、１回目の溶出で用いたマイクロチュ

ーブをそのまま 2 回目の溶出ステップで用いないでください。 

注：DNeasy のカラムはアプライ量の上限を守って使用することが重要です。 

1. 前もって、サーモミキサーを 56℃、ヒートブロックあるいは循環温浴漕を 56℃に設定します。 

無核赤血球からなる血液はステップ 2、有核赤血球からなる血液はステップ 3、培養細胞はステップ 4、

凍結組織はステップ 5、抽出した DNA の再精製はステップ 6 に進む。 

 

2 無核赤血球血液 (哺乳動物) 

2.1 20 μl の Proteinase K を 1.5 mL RNase-free Microfuge Tube の底の方にピペットで入れる。 

2.2 抗凝血処理された 50～ 100 μl の血液を添加する。 

2.3 Phosphate Buffered Saline pH 7.4 (PBS) で容量を 220 μl に調節する。 

2.4 ステップ 7 に進む。 

 

3 有核赤血球血液 (chicken など) 

3.1 20 μl の Proteinase K を 1.5 mL RNase-free Microfuge Tube の底の方にピペットで入れる。 

3.2 抗凝血処理された血液 5～10 μl を添加する。 

3.3 Phosphate Buffered Saline pH 7.4 (PBS)で容量を 220 μl に調節する。 

3.4 ステップ 7 に進む。 

 

4 培養細胞 

4.1 適切な数の細胞（最大 5 x 106 個）を 300 x g で 5 分間遠心分離する。ペレットを Phosphate Buffered 

Saline pH 7.4 (PBS)  200 μl で再懸濁する。 

4.2 20 μl の Proteinase K を添加する。 

4.3 ステップ 7 に進む。 

 

5 凍結組織 

5.1 25 mg（脾臓は 10 mg まで）を細かくカットし、1.5 mL RNase-free Microfuge Tube に入れる。 

5.2 180 μl の Buffer ATL(Qiagen DNeasy Blood & Tissue Kit に添付）を添加する。 

5.3 Proteinase K 20 μl を添加する。 

5.4 ボルテックス操作して混和する。 

5.5 組織が完全に溶解するまで、サーモミキサーで 450rpm 混和しながら 56℃でインキュベートする。 

溶解時間は使用する組織タイプにより変動します。溶解は通常 1～3 時間で完了します。溶解を一晩

中行なっても調製には影響しません。 

5.6 サンプルを室温にまで冷やしたあと、6,000 x g で 30 秒間遠心し、壁面のサンプルをすべてチュー

ブの底部に集める。 

5.7 ステップ 7 に進む。 

6 抽出した DNA の再精製 



オリゴ DNA マイクロアレイキット アレイ CGH プロトコル操作実習テキスト 20 

6.1 最大 25 μg の DNA を準備する。 

6.2 Phosphate Buffered Saline pH 7.4 (PBS)で容量を 220 μl に調節する。 

6.3 Proteinase K (Qiagen DNeasy Blood & Tissue Kit に添付） 20 μl を添加する。 

6.4 ステップ 7 に進む 

 

7 4 μl の RNase A（100 mg/ml）を添加し、ボルテックス操作して混和し、室温（15～25℃）で 2 分間イン

キュベートする。6,000 x g で 30 秒間遠心し、壁面のサンプルをすべてチューブの底部に集める。 

 

8 200 μl の Buffer AL（Qiagen DNeasy Blood & Tissue Kit に添付）を各サンプルに添加し、ボルテック

ス操作で完全に混和後、ヒートブロックまたは循環温浴漕により 56℃で 10 分間インキュベートする。

6,000 x g で 30 秒間遠心し、壁面のサンプルをすべてチューブの底部に集める。 

 

9 100% Ethanol 200 μl をサンプルに添加し、ボルテックス操作で十分にミックスする。6,000 x g で 30

秒間遠心し、壁面のサンプルをすべてチューブの底部に集める。 

 

10 ステップ 9 の混合液を新しい 2 ml コレクションチューブ（添付）中の DNeasy Mini Spin Column に移

す。6,000 x g で 1 分間遠心操作する。ろ液およびコレクションチューブを捨てる。DNeasy Mini Spin 

Column を新しい 2 ml コレクションチューブ（添付）に移す。 

 

11 Buffer AW1 を最初に使用する前に、容器に記載されている様に適切な量の 100％ Ethanol を加え調

製する。蓋のエタノール添加を示すチェックボックスに印をつける。 

 

12 500 μl の Buffer AW1 を添加し、6,000 x g で 1 分間遠心分離する。ろ液およびコレクションチューブ

を捨てる。DNeasy Mini Spin Column を新しい 2 ml コレクションチューブ（添付）に移す。 

 

13 Buffer AW2 を最初に使用する前に、容器に記載されている様に適切な量の 100％ Ethanol を加え調

製する。蓋のエタノール添加を示すチェックボックスに印をつける。 

 

14 500 μl の Buffer AW2 を添加し、20,000 x g で 3 分間遠心して DNeasy カラムメンブレンを乾燥させ

る。ろ液およびコレクションチューブを捨てる。 

 

15 DNeasy Mini Spin Column を新しい 1.5 ml マイクロチューブ（別途準備）に移し、200 μl の Buffer AE

を DNeasy メンブレン上の中央に直接添加する。 

 

16 室温（15～25℃）で 1 分間インキュベートした後、6,000 x g で 1 分間遠心分離し、DNA を溶出する。 

 

17 DNeasy Mini Spin Column を新しい 1.5 mL RNase-free Microfuge Tube に移し、ステップ 15、16 を

もう一度繰り返す。１回目の溶出液と２回目の溶出液を一緒にする。（最終容量 400μl） 
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7-2．ゲノム DNA の定量・品質確認 

ゲノム DNA の定量と質を正確に確認することはアジレント CGH マイクロアレイ実験を成功させるために重

要です。高品質のゲノム DNA として、炭水化物やたんぱく質、残存有機溶媒などの混入がなく、分解が最小

の Intact なものであるものを推奨します。 

 

FFPE 組織からゲノム DNA を抽出する方法につきましては、別途 Agilent Oligonuclotide Array-Based 

CGH for Genomics DNA Analysis (ULS Labeling for Blood, Cells, Tissues, or FFPE) Protocol (p/n 

G4410-90020)中の ”FFPE Tissues” の項目をご参照ください。SurePrint G3 CGH+SNP マイクロアレイを

使用する場合、FFPE サンプルはサポートいたしておりませんのでご留意ください。 

 

・ Qubit dsDNA BR Assay Kit を使い蛍光分析法で二本鎖 DNA の濃度を測定してください。 

・ NanoDrop ND-1000 UV-VIS Spectrophotometer （もしくはその相当品）を使いゲノム DNA の濃度と

純度を確認してください。 

・ アガロースゲル電気泳動を使い、各サンプルについてゲノム DNA が分解していないことや平均分子量

を確認してください。 

 

Note  高質なデータを得るために、蛍光分析法による定量方法を推奨します。 

 

蛍光分析法 

Qubit dsDNA BR Assay Kit は室温（22°C から 28°C）で使用します。温度が変動する環境ではアッセイの精

度に影響するおそれがあります。 

1. 専用の Thin wall, clear 0.5mL PCR tubes をスタンダード用 2 つとサンプル数用意します。 

2. Qubit Working Solution を調製します。 

スタンダードと測定するサンプルの数(+余剰分)に応じ

て右表の内容の混合物を調製し、ボルテックスミキサで

2-3 秒撹拌します。 

3. スタンダード用（Standard 1、Standard 2）に準備した 2 つの Thin wall, clear 0.5 mL PCR tubes に

190 µL の Qubit Working Solution を入れます※注意 1。 

4. サンプル用のチューブに 180～199 µL の Qubit Working Solution を入れます※注意 1。 

5. 10 µL の Qubit dsDNA BR standard #1 と Qubit dsDNA BR standard #2 を、３で準備したチュー

ブにそれぞれ加えます。 

6. 1～20 µL のサンプルを４で準備したサンプル用のチューブに加えます。（トータル 200μL に調製し

ます。） 

7. ボルテックスミキサで全てのチューブを 2 から 3 秒間撹拌します。泡ができないように注意してくださ

い。 

8. 室温で 2 分間チューブを静置します。 

 Qubit のキャリブレーションは次のように行います。 

a. Qubit 1.0 のホームスクリーンで上矢印または下矢印を使ってアッセイタイプに dsDNA Broad 

Range Assay を選択し、GO を押します。標準のスクリーンが自動で表示されます。 

1 測定物辺りの量 

Qubit dsDNA BR Reagent 1 uL 

Qubit dsDNA BR Buffer 199 uL 
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b. Run new calibration を選択し、GO を押します。 

c. standard 1 のチューブを Qubit Fluorometer に入れ、蓋を閉じ、GO を押します※注意 2。測定が

終わったらチューブを取り出してください。 

d. standard 2 のチューブを Qubit Fluorometer に入れ、蓋を閉じ、GO を押します※注意 2。測定が

終わったらチューブを取り出してください。 

これでキャリブレーションは完了です。 

 

 サンプル濃度の測定は次のように行います。 

a. サンプルのチューブを Qubit Fluorometer に入れ、蓋を閉じ、GO を押します※注意 2。 

b. 測定（約 5 秒）が終わったら測定値を記録してください。 

c. 結果はスクリーンに表示されます。表示された数値はアッセイチューブ内の核酸の濃度です。 

d. 装置からサンプルを取り出し、次のサンプルを入れ、GO を押します※注意 2。 

e. 全てのサンプルの測定が終わるまでくりかえしてください。 

f. 元のサンプルの濃度を計算してください。（下の「サンプル濃度の計算」を参照ください） 

g. 各サンプルのレプリケートの平均濃度を計算してください。 

 

サンプル濃度の計算 

Qubit Fluorometer の Qubit dsDNA BR assay では、測定値は µg/mL で与えられます。この測定値は

アッセイチューブ内で希釈されたサンプル濃度に相当します。サンプルの元の濃度を計算するためには、

次の式を使います。 

サンプル濃度 ＝ 測定値×（200／y） （y はアッセイチューブに加えたサンプルの容量です。） 

 

※注意１：Qubit Working Solution は粘性が高いので、分注時に正しく測りとるよう注意します。（例：リ

バース（インバース）ピペッティングの使用） 

※注意２：チューブを Qubit 本体に挿入した後、速やかに測定してください。 

 

UV-VIS 分光測定法 

NanoDrop による測定時の操作 

濃度が>350 ng/uL のときは Buffer AE や 1×TE(pH 8.0)で 2 倍に希釈し測定します。 

 

1. Nucleic Acid Measurement モードで、Sample Type を DNA-50 に設定して測定します。 

2. ゲノム DNA 抽出時の溶出バッファや、ゲノムＤＮＡを溶解しているバッファを 1.5μL、blank として測定。 

3. 各ゲノム DNA を 1.5μL 用いて測定します。 

4. DNA 濃度（ng/μL）と A260/280 と A260/A230 を記録します。高品質のゲノム DNA は A260/A280 値

は 1.8~2.0 で、タンパク質の混入が低いことを示します。220~320nm の吸光を連続スキャンすることで

260nm の吸光に影響する混入物がないことも確認できます。下図のように 260nm にピークがあり、全

体がなだらかな形あることを確認します。純度の高い DNA の理想的な 260/230 値は>1.0 です。 
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 典型的な pure DNA のスペクトル図  

 

アガロースゲル電気泳動 

DNA の Intactness を調べるためにアガロースゲル電気泳動を行うことを推奨します。 

 

例： 1.2% Clear E-Gel (20ng DNA を使用)、SYBR Gold Nucleic Acid Gel Stain* による手順 

* SYBR Gold Nucleic Acid Gel Stain, Invitrogen 社 [S11494] 

2 本鎖核酸に対する極めて高い感度のインターカレーター色素のため、少量サンプルでのゲノム

DNA の電気泳動を行うことが可能です。 

 

1. 20ng ゲノム DNA を DNase/RNase-free distilled water にて 10μL に調製し、1.2% Clear E-Gel

にアプライする。（loading buffer を加える必要はありません） 

2. コントロールとして、市販ヒトゲノム DNA 20ng を、DNase/RNase-free distilled water にて 10μL

に調製し、同じ gel のウェルのひとつにアプライする。 

3. TrackIt 1kb DNA Ladder 5uL を DNase/RNase-free distilled water 95μL に加え、そのうち 10μ

L を同じ gel のウェルのひとつにアプライする。 

4. Invitrogen 社 操作説明書に従い 30 分間電気泳動を行う。 

5. Invitrogen 社 操作説明書に従い E-Gel Opener にてゲルカセットをあける。 

6. ゲルを SYBR Gold Nucleic Acid Stain (DNase/RNase-free distilled water にて 1:10,000 に希釈

※)で 15 分間染色する。 

※10μL  SYBR Gold Nucleic Acid Stain を 100mL Nuclease-free 水に加える 

7. UV-transilluminator（SYBR Gold photographic filter 使用）にてゲルを確認する。 

  

A260 DNA濃度測定

A230 有機化合物（フェノール、アルコール、

guanidinium isothiocyanates 等）、

炭水化物（糖質）等の混入物

A280 タンパク質
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8. ラベル化前の反応 

 

この項目では、アジレントが推奨する２つのラベル化前の実験工程が記述されています。 

ダイレクト法（p.33）か増幅法（p.27）のいずれかをお選びいただけます。（ワークフロー図：p.18、p.26） 

注意 SurePrint G3 CGH+SNP マイクロアレイには増幅法はご使用いただけません。 

 

 

 

 

 

 

 

8-1．増幅法 （オプション） 

 

注意 増幅法でクオリティのいいデータを取得するためには、高品質の、断片化の進んでいないゲノムを使

用します。もし推奨以外の方法にてゲノム DNA を調製する場合は、ゲノム DNA に RNA やタンパク質が混

入しないように注意します。必要に応じて DNA の再精製を行ってください（p.19）。 

増幅法では reference DNA も増幅をおこない、分解度が Test サンプルと同様であることを確認します 

ピペッティングによりゲノム DNA が完全に溶解していることを確認します。必要に応じて 37℃30 分加熱し

ます。 

GenomePlex を使用した本法は、サイズ >500bp の DNA も使用可能ですが、その場合十分なラベル化

のための DNA を得るにはスタート量を極力増やすことを推奨します（100ng まで）。FFPE サンプルなど、

ゲノム DNA に、断片化だけでなくダメージ（核酸のクロスリンク・ヒストンなど核酸結合タンパク質への影

響・核酸の脱プリン化など）の可能性がある場合、本増幅法に適さない場合があります 

 

ゲノム DNA の量が限られているとき、増幅法を用いることにより 50ng から実験が可能です。ゲノム DNA が

0.5 μg 以上（1-, 2-, 4-pack マイクロアレイの場合）もしくは 0.2 μg 以上（8-pack マイクロアレイの場合）あ

る場合は、p. 33 のダイレクト法の手順をご覧ください。 

 

【原理】 

Sigma 社 GenomePlex Whole Genome Amplification kit (WGA2) を用いて、ゲノム DNA を増幅します。 

このキットは熱によるランダムなゲノム DNA 断片化の後、小さな断片を、両側に universal priming site を持

つ PCR 増幅可能な OmniPlex Library 分子に変換することによる、「リンカーを介したプライマーPCR 増幅技

術」を用いています。OmniPlex library は universal oligonucleotide primer を用いて PCR で増幅されます。

凍結組織や培養細胞を含めた多様なサンプル種からの抽出したゲノム DNA に適しております。 

 

【使用機器・消耗品】 

機器 □サーマルサイクラー（ふたを加熱できるもの） 

 □真空濃縮装置（例 Speed Vac）（増幅後の DNA の濃度が低い場合のみ必要） 

注意 制限酵素反応、ラベル化、ハイブリダイゼーションサンプル準備の全てのインキュベーションステップ

で、サーマルサイクラーの使用を推奨します。 

ヒートブロックの使用はサンプル間差を大きくする可能性があり、また、温浴槽の使用は特に高温において

温度が変動します。特に 98℃のインキュベーションでは、ヒートブロックや温浴槽ではなくサーマルサイクラ

ーを使用する効果が大きくなります。 
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 □遠心機（1.5mL チューブ対応、12,000～16,000xg で回転可能なもの） 

消耗品 □200 μL Thin-Wall Tube もしくは 96-well PCR plate 

 □DNase/RNase-free distilled water 

 □Ethanol 

 □GenomePlex Complete Whole Genome Amplification Kit 

 □GenElute PCR Clean-Up Kit   
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【参考資料】 

GenomePlex Whole Genome Amplification (WGA) Kit. Technical Bulletin. Sigma-Aldrich. 2006. 

TR/PHC 06/05-1 

 

 

 

  

血液・細胞・凍結組織から抽出
したExperimentalゲノムDNA

市販もしくは血液・細胞・
凍結組織から抽出した
Reference ゲノムDNA

ゲノムDNAの増幅 ゲノムDNAの増幅

増幅DNAの精製 増幅DNAの精製

ラベル化DNAの精製

増幅DNAの濃度測定と
収量測定

増幅DNAの濃度測定と
収量測定

DNAのラベル化 DNAのラベル化

ラベル化DNAの精製

ハイブリダイゼーション
前調製

24時間または40時間
ハイブリダイゼーション（67℃）

マイクロアレイの洗浄

マイクロアレイのスキャン

数値化(Feature Extraction)

解析（Agilent CytoGenomics または
Agilent Genomic Workbench）

増幅法（p.27～）のサンプル調製とマイクロアレイ操作 

 

 

調製にはゲノム DNA 50 ng 必要です。 
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8-1-１．断片化 

 

① 50ng のゲノム DNA を、200 μL Thin-Wall Tube または 96-well PCR plate に入れ、最終容量 10μL に

なるように DNase/RNase-free distilled water を加えます。 

（Reference と Experimental ゲノム DNA、それぞれ準備してください。） 

※断片化されたゲノム DNA の場合ゲノム DNA 量を増やすことをお薦めします。（上限 100 ng） 

 

 

 

  

 

 

 

② 10X Fragmentation Buffer Control Human Genomic DNA 1μL を加えます。ピペッティングでよく混合

します。 

 

③ 95℃、4 分加熱します。（サーマルサイクラーを用います。ふたの加熱 ON）4 分間は厳守してください。 

 

注意 この加熱操作は時間に強く影響します。加熱時間が変わると結果に影響することがあります。 

 

④ すぐに氷上に移します。遠心により壁面の水滴を底に集めます。速やかに次のステップに進んでください。 

 

注意 速やかに【ライブラリ調製】に進む必要があります。ライブラリ DNAの末端が分解することがあります。 

 

  

Reference ゲノム DNA 

（50～100ng） 

Experimental ゲノム DNA 

（50～100ng） 

ゲノム DNA:        μL 

Nuclease Free 水： μL 

（合計     10μL） 

ゲノム DNA:        μL 

Nuclease Free 水： μL 

（合計     10μL） 

0.2mL PCR チューブ 

または PCR plate 

0.2mL PCR チューブ 

または PCR plate 



オリゴ DNA マイクロアレイキット アレイ CGH プロトコル操作実習テキスト 28 

8-1-2. ライブラリ調製 

 

① 1X Library Preparation Buffer 2uL を加えます。 

 

② Library Stabilization Solution 1uL を加えます。 

よく混合します。遠心により液を底に集めます。 

 

③ 95℃、2 分間加熱します。（サーマルサイクラーを用います。ふたの加熱：ＯＮ） 

 

④ 氷上で急冷。遠心により液を底に集めます。 

 

⑤ Library Preparation Enzyme 1uL を加えます。 

よく混合します。遠心により液を底に集めます。 

 

⑥ 下記表のとおり加熱します。（サーマルサイクラーを用います。） 

 

 

 

⑦ 反応終了後、チューブをサーマルサイクラーから出し、遠心により液を底に集めます。 

（速やかに次のステップ「3. 増幅」に進むか、もしくは－20℃で３日間まで保存可能。） 

 

Step 温度 時間（分）

1 16℃ 20

2 24℃ 20

3 37℃ 20

4 75℃ 5

5 4℃ Hold
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8-1-3. 増幅 

 

① 下記のように増幅反応マスターミックスを調製します。 

 

 

② 各反応チューブに 60 uL の増幅反応マスターミックスを加えます（合計量が 75uL になります）。 

十分に混合し、遠心により液を底に集めます。 

 

  

 

 

 

 

③ 下記のプログラムで加熱します。（サーマルサイクラーを使用します。ふたの加熱：ＯＮ） 

 

 

 

④  反応終了後、チューブを４℃に置きます。 

（あるいは－20℃で 3 日間まで保存可能です） 

Volume

(uL)

X6

(+0.2反応)

x12

(+0.4反応)

x48

(+2反応)

x96

(+4反応)

10X Amplification Master Mix 7.5 46.5 93 375 750

Nuclease-Free water 47.5 294.5 589 2,375 4,750

WGA DNA Polymerase 5 31 62 250 500

total 60 372 744 3,000 6,000

Step 温度 時間

1 Initial Denaturation 95℃ 3分

2-3 step を 14サイクル

2 Denature 94℃ 15秒

3 Anneal/Extend 65℃ 5分

4 サイクル後 4℃ Hold

増幅反応 

マスターミックス 

増幅反応 

マスターミックス 

Reference ゲノム DNA の 

ライブラリ 

Experimental ゲノム DNA の 

ライブラリ 

60μL 60μL 
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8-1-4. PCR反応物の精製 

 

GenElute PCR Clean-Up Kit を使用します。 

 

操作を始める前に 

・ Wash Solution Concentrate のボトルに48mLのEthanol（96-100%）を加え、よく混合してください 

・ 全ての遠心のステップは、室温で行ってください。 

 

① GenElute MiniPrep Bindingカラムを Collection チューブにセットします。 

500 µLのColumn Preparation Solutionを加え、12,000xgで30秒～1分間遠心します。カラムを素

通りした液は捨てます。Collectionチューブは引き続き使います。 

 

 

 

 

 

 

② 375µLのBinding SolutionをPCR反応サンプル（75µL）に加えます。全量をカラムに移し、12,000～

16,000xgで1分間遠心します。カラムを素通りした液は捨てます。Collectionチューブは引き続き使いま

す。 

 

 

 

 

 

 

 

③ カラムをチューブに戻し、500 µLの調製済みのWash Solution（Ethanol が加えられたもの）をカラム

に加えます。カラムチューブを12,000～16,000xgで1分間遠心します。カラムを素通りした液は捨てま

す。Collectionチューブは引き続き使います。 

 

 

 

 

 

 

④ カラムを2mLコレクションチューブに戻し、カラムから Ethanol を完全に除去するために、さらに12,000

～16,000xg、２分間の遠心を行います。 
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⑤ 注意しながらカラムを新しい Collectionチューブに移します。50µLのElution Solution (10mM Tris, 

pH8.0)をカラムの中央に加え、室温で1分間静置します。静置後、12,000～16,000xg、1分間の遠心を

行います。PCR増幅物が溶出されます。 

 

 

 

 

 

 

※精製した DNA は、NanoDrop ND-1000 などの UV-VIS Spectrophotometer を利用して、濃度定量を行い

ます。精製した DNA はラベリング反応まで－20℃で保管することが可能です。 
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8-1-5. 増幅・精製ゲノムDNAの濃度測定 

 

NanoDrop ND-1000（UV-VIS Spectrophotometer）を使って、精製した増幅 DNA の濃度測定を行います。 

 

① Nucleic Acid Measurement を選択し、Sample Type を DNA-50 に設定します。 

 

② 1.5 uL の Elution Solution を使って、Blank の測定を実行します。 

 

③ 精製した DNA を 1.5 uL を使って、DNA 濃度を測定します。 各サンプルの DNA 濃度（ng/ul）を記録

します。 

 

④ 増幅収量（ug）を計算します。 

増幅収量（ug) = DNA 濃度(ng/uL) ×50(uL) / 1000(ng/µL) 

 

8-1-6. ラベル化前の増幅DNA調製  

 

2ug をラベル化に用います。 

① 増幅 DNA 2µg を新しい 200 μL Thin-Wall Tube（96-well PCR plate）に移します。 

それぞれ Nuclease-free 水で 26uL (1-, 2-, 4-pack)もしくは 13uL（8-pack）に調製します※。 

ラベル化には Test サンプルと Reference サンプルは同じ量必要です。 

 

② ゲノム DNA が上記容量を超える場合、真空濃縮装置（例 Speed Vac）でサンプルを濃縮します。 

   ※再溶解しにくくなるため、乾燥させすぎないように注意してください。 

 

③ゲノム DNA のラベル化ステップ（p.36）へ進んでください。（制限酵素反応(p.34) は不要です） 

  DNA は-20℃で保管する事ができます。 
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8-2 ダイレクト法  

 

注意 最適なパフォーマンスのために、高品質の、分解の進んでいないゲノムを使用します。もし本プロトコル

に記載されているゲノム抽出方法以外の方法にてゲノム DNA を調製する場合は、ゲノム DNA に RNA やタン

パク質が混入しないように注意します。必要に応じて、前の項目に記載されている方法にて抽出ずみの DNA

を再精製してください。 

ゲノム DNA はピペッティングにより完全に溶解されていることを確認してください。必要に応じて、37℃で 30

分インキュベーションしてください。濃度が>350 ng/uL のときは Buffer AE や 1×TE(pH 8.0)で 2 倍に希釈し

たあと、再度測定し濃度が正確かどうか確認します。 

 

スタートゲノム DNA を少なくとも 0.5 μg（1-, 2-, 4-pack マイクロアレイ） もしくは 0.2 μg （8-pack マイクロア

レイ）お持ちの場合はダイレクト法をお使いください。Experimenta と reference の両方で同じ量のゲノム DNA

をお使いください。必要なゲノム DNA の量と容量は、使用するマイクロアレイのフォーマットと、制限酵素反応

をラベル化反応の前に実施するかどうかに依存します。下表をご参照ください。 

 

Note  ラベル化反応の前に制限酵素反応を行う方法により、多様なサンプルにおいてクオリティのいい CGH

データが得られます。しかし制限酵素反応の代わりに random primer を加えた後の 98℃の加熱時間を長く

する方法でも高質のデータが得られます。（制限酵素反応を省略する場合は p.36 から開始してください） 

注意：SurePrint G3 CGH+SNP マイクロアレイをお使いの場合は制限酵素反応を省くことはできません。 

 

お手持ちのゲノム DNA の量が 50 ng～<0.5 μg (1-, 2-, 4-pack マイクロアレイ)もしくは<0.2 μg（8-pack マイ

クロアレイ）の場合は、増幅法（p.24）をご覧ください。  

 

サンプル必要量および上限容量 （HD と G3 マイクロアレイで共通です。） 

アレイフォーマット 1-pack 2-pack 4-pack 8-pack 

start ゲノム容量 0.5～1.0 μg 0.5～1.0 μg 0.5～1.0 μg 0.2～0.5 μg 

Start 容量上限 

制限酵素反応を行う場合 
20.2 μL 10.1 μL 

Start 容量上限 

制限酵素反応を省略する場合 
26 μL 13 μL 

 

【必要な機器・消耗品】 

機器 □サーマルサイクラー（ふたを加熱できるもの） 

 

消耗品 □1.5mL RNase-free Microfuge Tube (98℃に耐性のあるもの) 

 200 μL Thin-Wall Tube もしくは 96-well PCR plate 

 □SureTag Complete DNA Labeling Kit もしくは SureTag DNA Labeling Kit  

Rsa I、Alu I、10X Restriction Enzyme Buffer、BSA 

 □DNase/RNase-free distilled water 
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8-2-1. ゲノムDNAの制限酵素反応 

 

注意  制限酵素反応の前に DNA の濃縮が必要な場合、高濃度の塩・EDTA・混入物を制限酵素反応に

持ち込まないでください。 

 

① SureTag Complete DNA Labeling Kit または SureTag DNA Labeling Kit に含まれる 10X Restriction 

Enzyme Buffer および BSA を溶かし、それぞれチューブを指ではじき攪拌し、遠心機で液をチューブの

底に集めておきます。各試薬は使用時すべて氷上に置きます。使用が終わったら速やかに-20℃にもど

します。 

② 各反応の reference および Experimental ゲノム DNA を必要量（p.33 の表参照）200 μL Thin-Wall 

Tube もしくは 96 well PCR plate にいれ、DNase/RNase-free distilled water で 20.2μL（1-, 2-, 4-

pack マイクロアレイ）もしくは 10.1μL（8-pack マイクロアレイ）になるように調製します。 

 

  

 

 

 

③ 使用するマイクロアレイフォーマットに応じて、表に記載されている内容と順番で、制限酵素反応マスター

ミックスの調製を行います。マスターミックスを氷上に置き、氷上で下記の順に試薬を加え、ピペッティン

グでよく混合します。 ※注意：フォーマットにより容量が異なります。 

 

1-pack・2-pack・4-pack マイクロアレイの場合 

Component 1 反応 
x4 反応 

(+0.25 反応) 

x8 反応 

(+0.5 反応) 

x48 反応 

(+2 反応) 

X96 反応 

(+4 反応) 

Nuclease-free water 2.0 8.5 17 100 200 

10X Restriction Enzyme Buffer† 2.6 11.05 22.1 130 260 

BSA† 0.2 0.85 1.70 10 20 

Alu I† 0.5 2.125 4.25 25 50 

Rsa I† 0.5 2.125 4.25 25 50 

最終量 5.8 24.65 49.3 290 580 

8-pack マイクロアレイの場合 

Component 1 反応 
x8 反応 

(+0.5 反応) 

x16 反応 

(+1 反応) 

x48 反応 

(+2 反応) 

x96 反応 

(+4 反応) 

Nuclease-free water† 1.0 8.5 17 50 100 

10X Restriction Enzyme Buffer† 1.3 11.05 22.1 65 130 

BSA† 0.1 0.85 1.70 5 10 

Alu I† 0.25 2.125 4.25 12.5 25 

Rsa I† 0.25 2.125 4.25 12.5 25 

最終量 2.9 24.65 49.3 145 290 

 † SureTag Complete DNA Labeling Kit および SureTag DNA Labeling Kit に含まれます。 

④ ゲノム DNA サンプルが入った各反応チューブに 5.8 μL（1-, 2-, 4-pack マイクロアレイ）もしくは 2.9 μL

（8-pack マイクロアレイ）の制限酵素反応マスターミックスを加えます。ピペッティングでよく混合します。 

 

Reference ゲノム DNA Experimental ゲノム DNA 

ゲノム DNA:        μL 

Nuclease Free 水： μL 

（合計     20.2μL） 

ゲノム DNA:        μL 

Nuclease Free 水： μL 

（合計     20.2μL） 

0.2mL PCR チューブ 

または PCR plate 

0.2mL PCR チューブ 

または PCR plate 



オリゴ DNA マイクロアレイキット アレイ CGH プロトコル操作実習テキスト 35 

  

 

⑤ サンプルをインキュベーションします。 

サンプルチューブまたは plate をサーマルサイクラーに移します。サーマルサイクラーのプラグラムを下記の

ように設定し、反応を行います。反応終了後、チューブを氷上に移します。 

 

⑥ オプション：制限酵素消化物 2 uL を使って 0.8% agarose 電気泳動を行い、SYBR Gold (Invitrogen p/n 

S-11494)にて染色します。断片化されたゲノム DNA の大部分が 200～500bp であることを確認します。 

⑦ p.36 の「ゲノム DNA のラベル化」にすすむか、サンプルを-20℃で保存します。 

制限酵素処理 DNA は-20℃で１ヶ月まで保管する事ができます。 

  

Step I Step II Step III

37℃ 65℃ 4℃

２時間 20分 forever

制限酵素反応 

マスターミックス 

Reference ゲノム DNA Experimental ゲノム DNA 

5.8μL 

(8x60K, 8x15K 

フォーマット時 2.9μL) 

制限酵素反応 

マスターミックス 

5.8μL 

(8x60K, 8x15K 

フォーマット時 2.9μL) 
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9． ゲノム DNA のラベル化 

 

アジレント SureTag DNA Labeling Kit またはSureTag Complete DNA Labeling Kit には 

・ 25 スライド 1-pack, 2-pack, 4-pack マイクロアレイ 

・ 50 スライド 8-pack マイクロアレイ 

の２色法のラベル化反応に相当する試薬が含まれます。 

 

アジレント SureTag DNA Labeling Kit とSureTag Complete DNA Labeling Kit には、Cy3・Cy5 各

蛍光25反応（合計50反応分）に相当するclean-up columnが含まれます。8-pack マイクロアレイ使用

時、追加でcolumnをご発注ください。 

 

本キットでは、ランダムプライマーとExo-Klenow fragment を用いた反応で、ゲノムDNAを蛍光ラベル

化Nucleotide （Cyanine 3-dUTP、Cyanine 5-dUTP）により標識します。アジレント オリゴaCGHアプリ

ケーションでは、Experimentalを片方の蛍光で、Referenceサンプルをもう片方の蛍光で標識します。基

本的にExperimentサンプルをCyanine 5で、ReferenceサンプルをCyanine 3でラベル化します。 

 

9-1 ゲノム DNA のラベル化反応  

 

【前準備および注意】 

• 5x Reaction Buffer をなるべく光にさらさないようにしてください。5x Reaction Buffer の性能には影響し

ませんが、buffer の色が黄色くなります。 

• 使用前にキットに含まれる各試薬を溶かし、それぞれよく攪拌して均質に氷上に置きます。Exo-

Klenow fragment 酵素は使用時以外冷凍庫に保存してください。 

 

【使用機器および消耗品】 

機器 □サーマルサイクラー（ふたを加熱できるもの） 

消耗品  □SureTag DNA Labeling Kit またはSureTag Complete DNA Labeling Kit 

Random Primer、5X Reaction Buffer、10X dNTPs、 

Cyanine 3-dUTP、Cyanine 5-dUTP、Exo (-) Klenow  
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Note  Cyanine3-dUTP および Cyanine5-dUTP は露光による影響があり、繰り返し凍結融解で分解しま

す。ラベル化反応の工程では、光にあてる時間を最小にとどめてください。 

 

注意 Experiment / Reference サンプルペアは反応時同様に処理される必要があり、そうでないとデータ

の質に悪影響を及ぼすことがあります。熱変性の際、確実にサンプルペアを同じ温度で処理する最良の方

法はサーマルサイクラーを使うことです。 

 

① 反応サンプル溶液を 6,000 xg、１分間遠心し、チューブ内のふたや側面に付着したサンプルをすべて底

に集めます。 

 

② Random Primer を下記の量加え、静かにピペッティングを行いよく混合します。 

 

アレイフォーマット 1-pack 2-pack 4-pack 8-pack 

増幅法・ダイレクト法： 

加える Random Primer 量 
5 μL 2.5 μL 

 

合計のサンプル容量は 31 uL(1-pack, 2-pack, 4-pack の場合。35 ページのアガロースゲル電気泳動を

行った場合は 29 uL)または 15.5 uL(8-pack の場合。35 ページのアガロースゲル電気泳動を行った場

合は 13.5 uL)になります。 

 

③ サーマルサイクラーのプラグラムを下記のように設定しスタートボタンを押し 98℃になったら Pause ボタ

ンを押します。 

 

 温度 時間（ダイレクト法で制限酵素反応

を行った場合 

および増幅法の場合） 

時間（ダイレクト法で 

制限酵素反応を省略した場合） 

Step 1 98°C 3 分 10 分 

Step 2 4°C hold hold 

 

④ サンプルチューブまたはプレートをサーマルサイクラーに移し反応を開始します。 

⑤ 反応が終了したらサンプルを 6,000xg、1 分間遠心を行い、チューブ内のふたや側面に付着したサンプ

ルをすべて底に集め、氷上におきます。 

 

⑥ 使用するマイクロアレイフォーマットに応じて、氷上で表に記載されている内容と順番で試薬を混合し、

Cy3 用と Cy5 用のラベル化マスターミックスをそれぞれ調製します。 
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※ダイレクト法で制限酵素消化後に電気泳動（p. 35）を行わなかった場合、2uL の Nuclease-free water は

加えないでください。 （その場合、反応最終量は 19 uL もしくは 9.5 uL となります)。 

1-pack・2-pack・4-pack マイクロアレイの場合 

Component 1 反応 
x4 反応 

(+0.25 反応) 

x8 反応 

(+0.5 反応) 

X24 反応 

(+1 反応) 

X48 反応 

(+2 反応) 

Nuclease-free water 注意※ 2.0 8.5 17 50 100 

5x Reaction Buffer 10.0 42.5 85 250 500 

10x dNTPs 5.0 21.25 42.5 125 250 

Cyanine 3-dUTP or Cyanine 5-dUTP 3.0 12.75 25.5 75 150 

Exo (-) Klenow 1.0 4.25 8.5 25 50 

最終量 

（*水を加えたとき） 

19.0 

(*21.0) 

80.75 

(*89.25) 

161.5 

(*178.5) 

475 

(*525) 

950 

(*1050) 

8-pack マイクロアレイの場合 

Component 1 反応 
x8 反応 

(+0.5 反応) 

X24 反応 

(+1 反応) 

x48 反応 

(+2 反応) 

Nuclease-free water 注意※ 2.0 17 50 100 

5x Reaction Buffer 5.0 42.5 125 250 

10x dNTPs 2.5 21.25 62.5 125 

Cyanine 3-dUTP or Cyanine 5-dUTP 1.5 12.75 37.5 75 

Exo (-) Klenow 0.5 4.25 12.5 25 

最終量 

（*水を加えたとき） 

9.5 

(*11.5) 

80.75 

(*97.75) 

237.5 

(*287.5) 

475 

(*575) 

 

⑦ 各反応チューブ（ゲノム DNA サンプルが入ったチューブ）にラベル化マスターミックスを加え、静かにピペ

ッティングを行いよく混合します。 

 

 

 

 

合計のサンプル容量は 50 uL(1-pack, 2-pack, 4-pack の場合)または 25 uL(8-pack の場合)になりま

す。 

 

⑧ サーマルサイクラーのプログラムを下記のように設定し、スタートボタンを押し 37℃になったら Pause ボ

タンを押します。 

 

⑨ サンプルチューブまたは plate をサーマルサイクラーに移し、反応を開始します。 

⑩ 反応が終了したらサンプルを 6,000xg、1 分間遠心を行い、チューブ内のふたや側面に付着したサンプ

ルをすべて底に集めます。チューブを氷上に移します。 

 

 

※反応液は、暗所、-20℃にて、１ヶ月まで保管することが可能です。 

Step I Step II Step III

37℃ 65℃ 4℃

２時間 10分 forever

Cy3 ラベル化 

マスターミックス 

Cy5 ラベル化 

マスターミックス 
Experimental 

（または Reference） 

ゲノム DNA 

Reference（または

Experimental） 

ゲノム DNA 
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9-2 ラベル化 DNA の精製  

 

SureTag Complete DNA Labeling Kit または SureTag DNA Labeling Kit に含まれている Purification 

Column を用いて、ラベル化 DNA を精製します。 

Purification Column には以下のものが含まれています。 

・ Column 

・ 2-mL collection tube 

 

High-throughput の際の、AutoScreen A, 96-well plate [GE Healthcare 社製] を用いてラベル化 DNA を精

製する方法（オプション）につきましては英語版 Agilent Oligonucleotide Array-Based CGH for Genomic 

DNA Aalysis Protocol [G4410-90010] をご参照ください。 

 

Note  Cyanine3、Cyanine5 でラベル化された DNA は（混合せずに）それぞれ別に精製を行います。 

 

【必要な機器・消耗品】 

機器 □1.5mL チューブ対応の遠心機（14,000 xg で遠心可能なもの） 

 □真空濃縮装置（例 Speed Vac） (4x および 8x フォーマット使用時に必要) 

消耗品 □Agilent Purification Column 

 □1xTE (pH8.0) 

□1.5mL RNase-free Microfuge Tube (98℃に耐性のあるもの)、200 μL Thin-Wall Tube*、 

Tall Chimney PCR plate、96-well PCR plate* (*4x, 8x フォーマットのみ) のいずれか 

 

① 各反応チューブを 6,000 xg、１分間遠心を行い、チューブ内ふたや側面のサンプルを底に集めます。 

 

② 各反応チューブに 430 uL の 1 x TE (pH 8.0) を加えます。 

                                                                                                          

③ Column を 2-mL collection tube に入れ、サンプル名を記入します。各ラベル化 DNA 全量を column

に移します。 

 

④ Column に蓋をし、チューブを室温 14,000 xg で 10 分間遠心します。カラムを素通りした液を捨て、

column を今使用した 2-mL collection tube に戻します。 

 →遠心→  →   

  

1XTE buffer (pH8.0) 

 430μL 

1XTE buffer (pH8.0) 

 430μL 
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⑤ 480 µLの1 x TE (pH 8.0) をcolumnに加えます。チューブを室温14,000 xgで10分間遠心します。 

→遠心→   

⑥ 新しい2-mL collection tube にcolumnを逆さまにセットします。室温1,000 xgで1分間遠心し、精製サ

ンプルを回収します。（サンプル容量：約20～32μL） 

   →遠心→  

⑦ 回収したサンプルに 1 x TE (pH8.0)を加える、もしくは真空遠心濃縮装置で濃縮することで、下表に記

載されている容量に調製します。（過剰な乾燥は溶解困難になるためご注意ください。） 

 

   ※マイクロアレイのフォーマットごとに最終液量が異なります。 

アレイ 

フォーマット 

精製後の 

ラベル化 DNA 

容量 

NanoDrop 測定後に 

混合した（Cy3+Cy5） 

ラベル化 DNA 容量 

推奨調製容器 

1-pack 80.5 μL 158 μL 1.5mL RNase-free Microfuge Tube 

2-pack 41 μL 79 μL 
1.5mL RNase-free Microfuge Tube または

Tall chimney PCR plate 

4-pack 21 μL 39 μL 

1.5mL RNase-free Microfuge Tube, 200 μL 

Thin-Wall Tube, Tall chimney PCR plate また

は 96-well PCR plate 

8-pack 9.5 μL 16 μL 

1.5mL RNase-free Microfuge Tube, 200 μL 

Thin-Wall Tube, Tall chimney PCR plate また

は 96-well PCR plate 

 

⑧ よく混合します。⑦で完全に乾燥させた場合もしくは沈殿が生じた場合は、ゲノム DNA サンプルを氷

上に 5 分間置いた後、10 回ピペッティングします。 

 

⑨ 収量と色素取り込み率を確認するため、精製したラベル化 DNA 1.5 μL を使用します。p.41 の「UV

によるラベル化ＤＮＡの収量・蛍光取り込み率の確認」をご参照ください。高品質のゲノム DNA を用い

た場合の期待されるラベル化 DNA の収量および Specific Activity（色素取り込み率）は p.41 の表を

ご覧ください。 

 

⑩ 新しい 1.5mL RNase-free Microfuge Tube (98℃に耐性のあるもの)もしくは 200 μL Thin-Wall Tube

などに、正しい組み合わせの Cyanine-3 標識サンプルと Cyanine-5 標識サンプルにより、

Experiment と Reference サンプルの混合を行います。混合後の容量および推奨する調製容器につ

きましては上の表をご参照下さい。 

 

※精製、濃縮したラベル化 DNA サンプルは、暗所、-20℃にて、１ヶ月保管することが可能です。 

 

逆さまに入れる 
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9-3．UV によるラベル化ＤＮＡの収量・蛍光取り込み率の確認 

 

UV-VIS Spectrophotometer（NanoDrop 8000 または 2000、もしくはその相当品）を用いて、ラベル化 DNA

の収量・蛍光取り込み率の確認を行います。 

① NanoDrop使用時はNanoDropのソフトウェアを起動し、”Microarray Measurement”を選択します。

Sample TypeはDNA-50を選択します。 

② 1 x TE (pH8.0)を使って、Blank の測定を実行します。（NanoDrop 使用時は 1.5μL 使用） 

③ それぞれのラベル化 DNA を 1.5 μL 使って、A260nm（DNA 測定）、A550nm（Cyanine 3）、A650nm

（Cyanine 5）を測定します。  

④ A260 値から以下の式を使って DNA 濃度を計算します（NanoDrop 使用時は計算不要） 

ラベル化DNA 濃度 [ng/μL] = A260 × 50 [μg/mL] ÷光路長 [cm] *  × 希釈率  ・・・① 

※NanoDrop の光路長は 1 mm 

⑤ A550, A650 値から以下の式を使って Dye 濃度を計算します（NanoDrop 使用時は計算不要） 

Cy3 濃度 [pmol/μL] = A550÷（150 [mM-1cm-1] ×光路長 [cm] ）×1000 ×希釈率 ・・・② 

Cy5 濃度 [pmol/μL] = A650÷（250 [mM-1cm-1] ×光路長 [cm] ）×1000 ×希釈率 ・・・③ 

⑥ DNA 濃度（①）および Cy3 濃度（②）・Cy5 濃度（③）から、Cy3-dUTP および Cy5-dUTP の取り込み率

（Specific Activity）を計算します。 

Specific Activity [pmol/μg] = Dye 濃度 [pmol/μL] / ラベル化 DNA 濃度 [ng/μL] x 1000 

⑦ DNA 濃度から収量を計算します。 

DNA収量 [μg] = DNA濃度 [ng/μL] Ｘ サンプル容量 [μL] ÷1000 

 

高品質のゲノム DNA を用いた場合の期待されるラベル化 DNA の収量および Specific Activity（色素取り込

み率）は、下の表をご参照ください。 

 

制限酵素反応を「98℃のインキュベーション時間を長くする方法」に変更した場合、cyanine 3 標識サンプルと

cyanine 5 標識サンプルの Specific Activity は下の表の値から約 5 低くなります。収量やマイクロアレイのシ

グナルノイズ比は同じになります。 

 

SureTag Complete DNA Labeling Kit または SureTag DNA Labeling Kit を使用した場合 

Input gDNA (µg) Yield (µg) Specific Activity of Cyanine-3 and Cyanine-5 

Labeled Sample (pmol/µg) 

0.2* 3 to 6 15 to 50 

0.5 8 to 13 20 to 60 

1 9 to 14 20 to 60 

* 8x フォーマットマイクロアレイのラベル化反応時。8x フォーマットにて 500ng でラベル化した場合も含む。 

 

Cyanine-3 標識サンプルと Cyanine-5 標識サンプルの収量はほぼ同じになることが予想されます。もし大きく

異なる場合は p.89 トラブルシューティングをご覧ください。 
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10．マイクロアレイ操作 

 

マイクロアレイ操作には、ハイブリダイゼーション、洗浄、スキャンが含まれます。 

ハイブリダイゼーションの練習をする際は、2x HI-RPM Hybridization Buffer と水を 1 : 1 で混合した溶液を準

備し、使用済みのマイクロアレイスライドとガスケットスライドを使用して下さい。同じスライドを洗浄操作やスラ

イドホルダへの挿入の練習に使用することができます。 

 

操作を始める前に、p88 Secure Fit スライドボックスの開け方を参照してください。 

 

10-1. ハイブリダイゼーション 

 

【必要な機器・消耗品】 

 

機器 □ヒートブロック（98℃、37℃）もしくはサーマルサイクラー（ふたを加熱できるもの） 

（サーマルサイクラーは x4, x8 フォーマットのみ使用可能） 

 □ハイブリダイゼーションオーブン（67℃）20rpm で使用します 

 □ハイブリダイゼーションチャンバ 

 □アジレントハイブリダイゼーションチャンバ用ハイブリダーゼーションロ－タ 

 □遠心機（使用プレートもしくはチューブの 6000 xg 回転が可能なもの） 

消耗品 □ガスケットスライド 

  1x1M, 1x244K 用 [G2534-60003], 2x400K, 2x105K 用 [G2534-60002],  

  4x180K, 4x44K 用 [G2534-60011], 8x60K, 8x15K 用 [G2534-60014) 

 □アジレント マイクロアレイ 

□Cot-1 (生物種に対応したものを使用) 

□Agilent aCGH/ChIP-on-chip Hybridization Kit [5188-5220] 

□DNase/RNase-free distilled water 

 

【前準備】 

• 循環温浴漕（ヒートブロック）を 37℃に、ヒートブロックを 98℃に設定しておきます。もしくはサーマルサ

イクラーのプログラムを設定しておきます。 

循環温浴漕（もしくはヒートブロック）  または    サーマルサイクラー 

 

 

• ハイブリダーゼーションオーブンを 67℃に設定（ロ－タを取り付けておきます） 

 

10-1-1．10x aCGH Blocking Agent の準備 

 

① 軽くスピンダウンしてペレットをチューブの底に集めた後、DNase/RNase-free distilled water を 1,350 

μL、10x aCGH Blocking Agent に加えます。（Oligo aCGH/ChIP-on-Chip Hybridization Kit に含まれ

37℃ 98℃ PCR 
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ます。） 

 

② 60 分間、室温において、そのあとボルテックスで混合し、溶解させます。 

 

Note  調製後の 10 x aCGH Blocking Agent は、‐20℃で 120 日安定です。凍結融解は 3 回以内にしてくだ

さい。 

 

10-1-2．ハイブリダイゼーション溶液の調製 

 

① ヒートブロックもしくは循環温浴漕の温度を 98℃と 37℃にします。もしくはサーマルサイクラーを使用しま

す。 

② 使用するマイクロアレイのフォーマットに応じて、Hybridization Master Mix を調製します。2x Hi-RPM 

Hybridization Buffer は粘性が高く泡立ちやすいので、吸うときや混ぜるときはゆっくり実施してください。 

サンプルの生物種に合った Cot-1 をご使用ください。（推奨 Cot-1 については p.7~参照） 

注意 2x Hi-RPM Hybridization Buffer を冷蔵・冷凍保存しないでください 

1-pack マイクロアレイ 

Component 
1 反応 

（μL） 

X8 反応 

(+0.5 反応) 

（μL） 

X24 反応 

(+1 反応) 

（μL） 

X48 反応 

(+2 反応) 

（μL） 

Cot-1 DNA (1.0 mg/mL) 

(Human, Mouse, Rat) 
50 425 1,250 2,500 

10X aCGH Blocking Agent 52 442 1,300 2,600 

2X Hi-RPM Hybridization Buffer 260 2,210 6,500 13,000 

Master Mix 量 362 3,077 9,050 18,100 

2-pack マイクロアレイ 

Component 
1 反応 

（μL） 

X8 反応 

(+0.5 反応) 

（μL） 

X24 反応 

(+1 反応) 

（μL） 

X48 反応 

(+2 反応) 

（μL） 

Cot-1 DNA (1.0 mg/mL) 

(Human, Mouse, Rat) 
25 212.5 625 1,250 

10X aCGH Blocking Agent 26 221 650 1,300 

2X Hi-RPM Hybridization Buffer 130 1,105 3,250 6,500 

Master Mix 量 181 1,538.5 4,525 9,050 

4-pack マイクロアレイ 

Component 
1 反応 

（μL） 

X8 反応 

(+0.5 反応) 

（μL） 

X24 反応 

(+1 反応) 

（μL） 

X48 反応 

(+2 反応) 

（μL） 

Cot-1 DNA (1.0 mg/mL) 

(Human, Mouse, Rat) 
5 42.5 125 250 

10X aCGH Blocking Agent 11 93.5 275 550 

2X Hi-RPM Hybridization Buffer 55 467.5 1,375 2,750 

Master Mix 量 71 603.5 1,775 3,550 
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8-pack マイクロアレイ 

Component 
1 反応 

（μL） 

X8 反応 

(+0.5 反応) 

（μL） 

X24 反応 

(+1 反応) 

（μL） 

X48 反応 

(+2 反応) 

（μL） 

Cot-1 DNA (1.0 mg/mL) 

(Human, Mouse, Rat) 
2 17 50 100 

10X aCGH Blocking Agent 4.5 38.25 112.5 225 

2X Hi-RPM Hybridization Buffer 22.5 191.25 562.5 1,125 

Master Mix 量 29 246.5 725 1,450 

 

③ 正しい量の Hybridization Master Mix をラベル化 DNA の入った容器（1.5 mL RNase-free Microfuge 

Tube, 200 μL Thin-Wall Tube, Tall Chimner PCR plate, 96-well PCR plate）に加えます。 

加えた後の容量は下の表をご参照ください。 

 

アレイ 

フォーマット 

Hybridization Master 

Mix 

の容量 

NanoDrop 測定後に 

混合した（Cy3+Cy5） 

ラベル化 DNA の溶液量 

混合後の前容量 

1-pack 362 μL 158 μL 520 μL 

2-pack 181 μL 79 μL 260 μL 

4-pack 71 μL 39 μL 110 μL 

8-pack 29 μL 16 μL 45 μL 

 

④ ピペッティングでゆっくりとサンプルを混合した後、遠心器でスピンダウンを行い、液を反応容器の底に集

めます。 

 

サンプルチューブを98℃の循環温浴漕またはヒートブロックに移し、98℃で3分間インキュベーションしま

す。その後速やかにサンプルのチューブを37℃の循環温浴漕またはヒートブロックに移します。37℃で

30分間インキュベーションします。※インキュベーション中は必ず遮光をして下さい。 

 

もしくは 

サンプルチューブまたはplateをサーマルサイクラーに移します。サーマルサイクラーのプラグラムを下記

のように設定し、反応を行います。 

Step 温度 時間（分） 

1 98℃ 3 

2 37℃ 30 

 

⑤ 反応終了後、サンプルチューブを循環温浴漕・ヒートブロック・サーマルサイクラーからとりだします。遠

心機で6,000 g、1分間スピンダウンして、蓋や壁についた液を底に集めます。 

 

直ちにハイブリダイゼーションのステップに進んでください。保存はできません。  
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注意  サンプルはすぐにハイブリダイゼーションする必要があります。直後にハイブリダイゼーションできない

場合は、ヒートブロックやサーマルサイクラー、オーブンなどでハイブリダイゼーションサンプルミックスを極力

37℃に近い温度で保ってください。（15 分以内にハイブリダイゼーションを完了してください。一度に操作する

サンプル数を増やしすぎないようにします。） 
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10-1-3．ハイブリダイゼーションチャンパの組み立て 

 

注意 ハイブリダイゼーションの温度はマイクロアレイのシグナル強度やノイズレベルに大きな影響を及ぼ

します。表示温度と実測値が一致するかどうか 3 ヶ月に 1 度は確認し、0.2 ℃以上異なる場合は下記手順

で校正してください。 

 

≪ハイブリダイゼーションオーブン温度の校正法≫ 

1. オーブンのロ－タと、使用するスライド数とバランスをあわせてチャンバをセットします。 

2. 温度を 67℃、回転数を 20 にセットし、温度が安定するまで 3 時間ほど待ちます。 

3. 校正済みの温度計をセットします。 温度センサー部位をとりつけます。この時センサー部位がオ

ーブンの壁につかないように、空間の温度をはかるようにして下さい。 

4. 3 時間程度、温度計の温度が安定するまで待ちます。 

5. 実測温度と設定温度を比較し、0.2 ℃以上異なるようであれば、次の手順で合わせます。 

6. オーブンの ▲ ボタンと ▼ボタンを同時に押し、温度表示が点滅するまで待ちます。あるいは 

▲ ボタンと ▼ボタンを同時に長押し、温度両側の「.」が点滅するまで待ちます。 

7. 点滅しているうちに、▲ボタンと▼ボタンで、表示温度を温度計が示す温度にあわせます。 

8. その後再度表示を 67℃にあわせ 3 時間ほど待ち、表示温度が実測値と合うか確認します。 

詳細は弊社サポートサイトの「Agilent G2545A ハイブリダイゼーションオーブン校正方法」をご

覧ください。 

 

【ハイブリダイゼーション前の注意】 

• マイクロアレイはバーコードラベルに”Agilent”の文字が入っている面に載っています。Agilent の文字

が入っているほうが Active サイド、数字だけのバーコードラベルが付いている面は Inactive サイドにな

ります。 

 

• スライドグラスを取り扱う際は手袋をはめ、スライドグラスの縁を注意深く持って取り扱って下さい。スラ

イド表面には両側とも決して触らないで下さい。 

• スライドグラスを取り扱う際は、必ずパウダーフリーの手袋を着用してください。 

• 水平な机の上で操作してください。下記ハイブリエイドをお持ちの場合は、内蔵の水準器で水平が確認

できます。ハイブリダイゼーション作業を始める前に、予めご確認ください。 

• ハイブリダイゼーション、洗浄のステップでアレイを乾燥させないように注意して下さい。 

• 手でアレイスライドをガスケットスライドに乗せるのが難しい場合、オプションとして、ハイブリエイドを用

いてアレイスライドを乗せることが出来ます。（p.49 をご参照ください。） 

※ハイブリエイドはハイブリダイゼーション作業を補助するオプションの器具です。 

 

操作を始める前に、p88 Secure Fit スライドボックスの開け方を参照してください。 

 

アレイ搭載面 
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①ハイブリダイゼーションチャンバを解体します 

クランプアッセンブリのスクリューを緩め、横にスライドさせチャンバベースからはずしたあと、チャンバカ

バーをはずします。 

 

 

 

 

 

 

②ピンセットを使ってガスケットスライドのプラスチックカバーの端をつ

まみ、ゆっくりとはがします。ガスケットスライドをパッケージから取り

出します。この時、スライドの縁以外には触れないようにしてくださ

い。必ずパウダーフリーの手袋を着用してください。 

 

③ ガスケットスライドを、ガスケットのラベルシールが貼られて

いる面（ガスケットが搭載されている面）を上にして、チャン

バベースの上に載せます。ガスケットスライドは、ハイブリダ

イゼーション溶液を介して直接アレイに触れますので、ほこ

り等がつかないようにすばやくセットしてください。 

 

ガスケットスライドがしっかりとチャンバ－ベースにセ

ットされているか確認し、正しくされていない場合は、

再度セットし直してください。 

（オプションのハイブリエイドを用いる場合、 

ここで次々ページの p.49 【参考手法】を参照下さい） 

 

④ ハイブリダイゼーション溶液をガスケットスライド上にアプライします。 

※マイクロアレイのフォーマットごとにハイブリダイゼーション量が異なります。 

アレイフォーマット 1-pack 2-pack 4-pack 8-pack 

ハイブリダイゼーション量 490 μL 245 μL 100 μL 40 μL 

 

ハイブリダイゼーション溶液が均一に広がるように、以下

の方法でアプライしてください。チップの先をガスケットスラ

イドから少し離し、一方のガスケットの端から逆の端に向か

って移動しながらアプライします。この時、チップの先がス

ライドの表面になるべく触れないように注意してください。 

 

注意  サンプルはすぐにハイブリダイゼーションする必要があります。直後にハイブリダイゼーションできな

い場合は、ヒートブロックやサーマルサイクラー、オーブンなどでハイブリダイゼーションサンプルミックスを

極力 37℃に近い温度で保ってください。（15 分以内にハイブリダイゼーションを完了してください） 
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⑤ アレイ面(Agilent と書かれているバーコード面) を下にし

て、アレイスライドのラベルシールとガスケットスライドの

ラベルシールが向かい合うようにし、アレイスライドをチ

ャンバベースにセットされているガスケットスライド上に載

せます。このとき、アレイスライドのふちまたはバーコード

シール部分を持つようにしてください。アレイスライドを水平に保ったままガスケットスライドにのせます。 

アレイを正しくセットした後、チャンバや重なっているスライドグラスを動かさないようにしてください。ハイ

ブリダイゼーション溶液が漏れる原因になります。（オプションのハイブリエイド用いる場合、ここで p.49 

【参考手法】を参照下さい） 

 

注意 ・2 枚のスライドのラベルシールが、正しい位置で重なり合うようにセットしてください。 

 ・1 スライドに複数のアレイが搭載されているタイプで、チャンバカバーをセットする前、“サンプル溶液

が接しているアレイ”と“接していないアレイ”があるように見える場合がありますが、問題ありません。

アレイスライドを乗せた後は、位置の微調整などは行わず、すぐチャンバカバーを乗せて下さい。 

 

⑥ チャンバカバーを、チャンバベースの上にセットします。カバ

ーの向きを間違えないように注意してください。 

 

 

 

⑦ クランプアッセンブリを、チャンバベースの丸くなっているコ

ーナー側から差し込み、完全にストップする位置まで移動さ

せます。ストップする位置は、ちょうどチャンバの中央部に

なります。 

 

⑧ チャンバが水平に保たれていることをご確認した後、手でス

クリューをしっかり締めます。チャンバにダメージを与える可

能性があるので、ペンチなどの道具は決して使用しないでく

ださい。 

 

⑨ 組み立て終了後、チャンバを垂直方向にして 2,3 回、回転させて、ハイブリ溶液がスライドガスケットの全

面に行き渡るようにします。次に、チャンバ内の泡が自由に動くことができるか確認してください。泡が動

かない場合には、チャンバを軽くタッピングして、泡を移動させます。ハイブリ溶液が行き渡っていない部

分や、固定している泡により、ハイブリむらが起きる場合があります。 
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※参考手法 

ハイブリエイドを用いることにより、手作業では水平に降ろしづらいマイクロアレイスライドを、サンプルを

アプライしたガスケットスライド上に安定して乗せることが出来ます。 

使用器具： ハイブリエイド (HYB-100) 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

① ガスケットスライドにサンプルをアプライし終

わった時点でチャンバベースの両端から各

ハイブリエイドを差し込み、突き当たるまで動

かします。ガスケットスライドの端を、ハイブリ

エイドの突起部分が覆うような形となります。 

 

② アレイ面(Agilent と書かれているバーコード

面) を下にして(数字が書かれている方のバ

ーコード面は上に)、マイクロアレイスライドを

ハイブリエイド上に乗せます。アレイスライド

の縁またはバーコードシール部分を持つよう

にして下さい。バーコードシール側を先にハ

イブリエイドの上に置き、そこを押さえながら

もう片方をゆっくり下に倒すと作業が容易で

す。チャンバベースの 4 つの突起に当たらな

いように注意して下さい。この時、アレイスラ

イドはハイブリエイドに支えられてハイブリ液

には接していません。 

 

③ 左右のハイブリエイドを同時に引き抜いて下

さい。アレイスライドが水平に落ち、ガスケッ

トスライドと正しい位置で重なります。アレイ

スライドを乗せた後は、位置の微調整などは

行わず、すぐチャンバカバーを乗せて下さ

い。引き抜く先に障害物などが無いようにし

て下さい。 
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10-1-4．ハイブリダイゼーション 

 

① チャンバの組み立てが終わりましたら、予め 67℃にセットしたハイ

ブリダイゼーションオーブンのロ－タのラックに 

差し込みます。真ん中位置のラック（左から 3-4 番目）からチャン

バを入れます。 

 

注意 オーブンのモータに負荷をかけないためにバランスを 

とるよう向かい側のラックにもチャンバをセットします。 

 

ハイブリダイゼーションオーブンの扉を閉め、回転数を 20 に設定します。 

 

② 67℃で下記の時間ハイブリダイゼーションさせます。 

※マイクロアレイのフォーマットによりハイブリダイゼーションの時間が異なります。 

アレイフォーマット 1-pack 2-pack 4-pack 8-pack 

ハイブリダイゼーション回転速度・温度 67℃、20 rpm 

ハイブリダイゼーションの時間 40 時間 24 時間 

 

Note  洗浄工程で使用する Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 2 は終夜で予め温めておく必

要があります。マイクロアレイをハイブリしている間に p.52 の内容を実施して下さい。 

 

正 誤 
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10-2. マイクロアレイの洗浄 

 

Note  Cyanine 5 シグナルの分解が、環境・ラボ内機器などからのオゾンもしくは窒素酸化化合物により

起こることがあります。低オゾン濃度（＜5ppb）の環境において洗浄・スキャンを行ってください。（推奨：オ

ゾン除去フィルタの使用） 

※オゾン除去フィルタの採用が難しい場合、Stabilization and Drying Solution を使用する。かつ１度に処

理するスライドの数を少なくし、空気にさらされる時間を極力短くする。（約 40 分以内） 

 

【必要な機器・消耗品】 

 

機器 □スライドラック（小または中）１個 

 □スライド洗浄ガラス容器（小または中） ３個 （Stabilization and Drying Solution 使用時は５個） 

 □回転子２個 （Stabilization and Drying Solution 使用時は４個） 

  スライドラック小（ガラス容器小）で洗浄する場合 3.0cm 程度のもの 

  スライドラック中（ガラス容器中）で洗浄する場合 4.5cm 程度のもの 

  回転子の大きさが十分でない場合、洗浄力が弱くなる恐れがあります。 

 □フラットピンセット 33A（オプション） 

 □オゾン除去フィルタ（強く推奨） 

 □スターラー 

 □スターラー付恒温槽（株式会社日伸理化、品番：SW-500HT） 

 □タイマー 

 □99.9%窒素ガスもしくはブローワー 

スライドガラス表面に付着したホコリを吹き飛ばすのに使用 

 □ヒュームフード(ドラフト)（Stabilization and Drying Solution 使用時） 

消耗品 □Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 [5188-5226 もしくは 5188-5221] 

 □Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 2 [5188-5226 もしくは 5188-5222] 

 □Agilent 10%Triton X-102 [5185-5975]（オプション） 

 □Agilent Stabilization and Drying Solution [5185-5979] （オプション） 

 □アセトニトリル（Stabilization and Drying Solution 使用時） 

アセトニトリルによるアレイ洗浄により、Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 およ

び 2 からの残渣の Stabilization and Drying Solution への持ち込みを低減します。 

 □パウダーフリーの手袋（ニトリルグローブ） 

パウダーフリーの表示があっても、蛍光を持つ粒子が手袋についている場合があります。事前に、

ビーカーに入れた Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer１で手袋を事前に洗い、手袋

から垂れる液が白濁していないこと、および手袋を洗った後の、ビーカー内の溶液に微粒子がな

いことを確認してください。手袋から発生する微粒子は、アレイの表面に吸着して結果に大きな影

響を及ぼします（手袋から粒子が生じる場合は、p.57 をご参照ください。二トリルグローブとフラッ

トピンセット 33A のどちらかをアレイの洗浄ステップで使用することをお勧めします）。 
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マイクロアレイ洗浄用器具類（スライドラック・スライド洗浄ガラス容器・回転子・フラットピンセット）は、CGH 実

験用に新たにご購入いただいた上、他のアプリケーション（遺伝子発現、miRNA など）から使用を分けてくだ

さい。また、各ステップで使用する容器は、同じステップでお使い続けることをお勧めします。 

 

Triton X-102 の Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 および 2 への添加（オプション） 

これまでに他のアプリケーション（遺伝子発現、miRNA など）に使用していた器具類を CGH 用に使用される

場合、バックグラウンドのむらなど、マイクロアレイの洗浄におけるアーチファクトの影響が出ることがありま

す。その場合は容器のアセトニトリル洗浄を行ってください。それでも軽減されないようであれば新規 CGH

用としての器具類をご購入いただくか、最終濃度 0.005%になるように、Triton X-102 [5185-5975]を

Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 と 2 を加えることにより、その影響を軽減することがで

きます。 

Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 と 2 の開封時に、以下の方法で Agilent 10%Triton X-

102 [5185-5975] を加えます。 

1-1）.ダンボール箱中の容器の、外蓋と中蓋を注意深く開ける 

1-2）.ピペットで 2mＬの 10％ Triton X-102 を容器中の Wash Buffer に加える 

1-3）.中蓋・外蓋をきっちり戻し、5・6 回容器全体を転倒混和して、注意深くかつしっかり混ぜる。 

 1-4).中蓋・外蓋を外し、Buffer に添付の蛇口を取り付ける 

1-5). Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer の容器に『Triton X-102 添加済』と記載し、

日付を記録する 

Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer が開封済みの場合、同じ割合で（終濃度 0.005%）添加

してご使用ください。 

 

洗浄工程を実施する際はいつも清潔な洗浄器具をご使用ください。（購入直後も洗浄してご使用ください。） 

 

BG Noise が高いときや定期的な洗浄容器のメンテナンスなど、（Stabilization and Drying Solution を使用し

ない場合でも）必要に応じて Milli-Q ultrapure water による洗浄（p.53 10-2-2）以外に、アセトニトリルによる

洗浄を実施してください（p.53 10-2-3） 

 

注意 界面活性剤の中には蛍光が洗浄器具に残るものもあるため、洗浄器具を洗浄する際、界面活性剤

を使用しないでください。 

 

10-2-1. Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 2の加温（終夜） 

 

最適な条件として Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 2 の温度が 37℃である必要があります。 

Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 2 の必要な量を Sterile storage bottle に分注し、インキュ

ベータや循環温浴漕などで 37℃に予め終夜温めておきます。（もしくは Agilent Oligo aCGH/ChIP-on-Chip 

Wash Buffer 2 の容器ごとエアインキュベータで終夜 37℃に温めておきます。） 

 Wash Buffer 2 での洗浄時にスライド洗浄ガラス容器を、milli-Q ultrapure water が入った 1.5 L ガラス容器

に入れて保温する場合は、1～2L の milli-Q ultrapure water と洗浄用ガラス容器も 37℃で温めておきます。 
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10-2-2. 洗浄器具の洗浄 

１． 洗浄器具（スライドラック・スライド洗浄ガラス容器・回転子・フラットピンセット）を Milli-Q ultrapure water

でよく洗います。（洗剤を使わない。洗剤が残っている器具を使用すると、マイクロアレイに洗剤が付着し

蛍光を発する場合があります。） 

２． Milli-Q ultrapure water でよくすすぎます。5 回ほどすすいでください。 

３． ほこりがつかないように乾燥させてください。 

※各洗浄ガラス容器は各使用洗浄試薬専用に使用することを推奨します。 

 

10-2-3. 洗浄器具のアセトニトリルによる洗浄（Stabilization and Drying Solution使用時） 

 

アセトニトリル洗浄によりスライドラック・スライド洗浄ガラス容器・回転子・フラットピンセットに残った

Stabilization and Drying Solution 残渣を除去します。 

 

警告 アセトニトリル洗浄はヒュームドラフト内で実施してください。アセトニトリルは揮発性、引火性の溶液で

すので、取り扱いにご注意ください。 

 

１． スライド洗浄ガラス容器にスライドラック・回転子・フラットピンセットを入れ、スターラーの上に置きます。 

２． スライド洗浄ガラス容器に 100 % アセトニトリルを満たします。 

３． スターラーの回転速度を中程度の速度に設定します。（もしくは 350 rpm） 

４． 室温で５分間洗浄します。 

５． アセトニトリルを施設内の規定に則り廃棄します。 

６． １～５の工程を再度実施します。 

７． ヒュームドラフト内ですべての器具を乾燥させます。 

８． 続いて 10-2-2 の内容にしたがって Millli-Q ultrapure water で洗浄します。 
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10-2-4. Stabilization and Drying Solutionの加温（Stabilization and Drying Solution使用時） 

Agilent Stabilization and Drying Solution はアセトニトリルに溶解させたオゾン除去剤を含みます。オゾン除

去剤は飽和状態になっているため、沈殿物を生じる場合があります。目に見える沈殿があった場合には、以

下の手順で溶液を加温して、沈殿物を再溶解してください。 

 

警告 Stabilization and Drying Solution は、揮発性、引火性の溶液ですので、取り扱いに注意を要して下

さい。 

警告 警告に従わず火事、爆発による個人的な傷害を負った場合、アジレントの補償対象外になりますの

で、充分注意して取り扱って下さい。 

警告 Stabilization and Drying Solution 溶液の加温は必ず下記の方法に従って行ない、ホットプレー

ト・電子レンジ（オーブン）・インキュベーター(孵卵器)などでは行わないでください。 

温度を急激に上げないで下さい。さらに、引火性物質を近くに置かないで下さい。 

インキュベーター(孵卵器)などを使用して密閉空間で加温すると溶剤であるアセトニトリル

が気化して充満し、爆発事故や高濃度のアセトニトリルの吸引による健康被害の原因となる

可能性があります。 

 

① ヒュームフード(ドラフト)内で 40 - 45℃の循環温浴漕を用いてゆっくりと溶液を加温します。十分な空気の

ヘッドスペース容量がある容器に溶液をいれ、密閉した状態で加熱してください。 

 

出荷時に Stabilization and Drying Solution 溶液が入っていたオリジナル容器は加温にお使いいただけます。

オリジナル容器は 700 mL サイズで、500 mL の溶液が入っています。オリジナルと異なる容器を使う場合に

は、この空気部分のヘッドスペースと溶液の割合がオリジナル時以上になることをご確認ください。沈殿物を

完全に再溶解させるのに必要な時間は、沈殿物の量によって異なります。沈殿量が多い場合には、オーバー

ナイトでの加温が必要になることもあります。 

 

② 溶液を均一に溶解するために、緩やかな攪拌が必要になる場合があります。必要に応じて、ヒュームフー

ド(ドラフト)内で火気を避けて行ってください。 

 

③ 沈殿が溶解しましたら、室温に戻してから洗浄に使用してください。 

 

注意 Stabilization and Drying Solution は決してろ過しないでください。オゾンスカベンジャーの濃度に影

響します。 
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10-2-5. マイクロアレイの洗浄 

 

１連の洗浄工程ごとに、新しい Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 と Agilent Oligo 

aCGH/ChIP-on-Chip Wash Buffer 2 をお使いください。 

 

Step 容器 洗浄液 温度 時間  

チャンバ分解 #1 
Agilent Oligo aCGH/ChIP-

on-Chip Wash Buffer 1 
室温  

 

洗浄１ #2 
Agilent Oligo aCGH/ChIP-

on-Chip Wash Buffer 1 
室温 5 分 

 

洗浄２ #3 
Agilent Oligo aCGH/ChIP-

on-Chip Wash Buffer 2 
37℃ １分 

 

アセトニトリル洗浄 

(Stabilization and 

Drying Solution 

使用時) 

#4 アセトニトリル 室温 10 秒 
 

洗浄３ 

(Stabilization and 

Drying Solution 

使用時) 

#5 
Stabilization and Drying 

Solution 
室温 30 秒 

 

 

① 洗浄容器 #1 に Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 を入れます（室温）。 

 

② 洗浄容器 #2 を準備します。 

A) スライドラックを洗浄容器#2 に入れます。 

B) 回転子を中に入れます。Agilent Oligo aCGH/ChIP-on-Chip Wash 

Buffer 1 を、スライドラックが十分に浸かるくらい入れます（室温）。 

 

③ 洗浄容器 #3 を準備します。 

A) 洗浄容器 #3 に Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 2

（37℃）を入れます。（容器 80%程度の量） 

B) 回転子を中に入れます。 

C) スターラー付恒温槽がある場合には 37℃にしておき、洗浄容器 #3 を

入れます（右の写真参照）。 

温度調節機能付きのスターラーを使用する場合は、スターラーの上にあらかじめ 37℃で温めてお

いた milli-Q ultrapure water が入った 1.5 L ガラス容器を乗せ、そこに洗浄容器 #3 を入れます。 

スターラー付恒温槽を利用しない場合は、洗浄１が開始した後に（洗浄２の直前に）③の準備を開始します。 

 

④ （Stabilization and Drying Solution 使用時） ヒュームドラフト内で洗浄容器 #4 にアセトニトリルを入れ

ます（室温）。 回転子を中にいれておきます。 

 

⑤ （Stabilization and Drying Solution 使用時） ヒュームドラフト内で洗浄容器 #5 に Stabilization and 

Drying Solution を入れます（室温）。 回転子を中にいれておきます。 
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警告 アセトニトリルおよび Stabilization and Drying Solution を使う場合、ヒュームフード(ドラフト)内に洗

浄容器 #4 と #5 を準備します。 

⑥ ハイブリダイゼーションオーブンからハイブリダイゼーションチャンバを取り出します。複数のアレイをハイ

ブリダイゼーションしている場合も、チャンバは必ず１つずつ取り出すようにしてください。泡が形成されて

いるか、また泡が自由に動いているか確認してください。 

 

注意 チャンバをハイブリダイゼーションオーブンから取り出し、室温で静置すると、放置時間に応じて、ハイ

ブリ液の覆っている部分と気泡の部分で、シグナル強度に差異を生じます（下図参照）。オーブンから取

り出したチャンバは、必ずすぐ

に 解 体 し 、 ア レ イス ラ イドを

Wash1 中のスライドラックに移

すことが重要です。また複数枚

のスライドを一度に wash する

場合も、1 スライドずつ取り出

し、解体の直前まで、規定の

温度に保温されていることが

重要です。 

 

 

⑦ チャンバを分解します。 

A) チャンバを水平な台の上に置き、スクリューを逆時計回りにまわしてゆるめます。 

B) クランプアッセンブリを外し、チャンバカバーを取り除きます。 

C) 手袋をはめた手で、チャンバベースから重なっている 2 枚のスライドを同時に取り出します。この時、

スライドの両端をしっかり持つようにしてください。すぐに、アレイスライドを上にした状態で(数字が

書かれているバーコード面を上にして)、2 枚のスライドが重なっている状態で Agilent Oligo 

aCGH/ChIP-on-Chip Wash Buffer 1 の入っている洗浄容器 #1 に浸けます。 

 

⑧ 2 枚のスライドが完全に Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 に浸かった状態で、スライ

ドのバーコード側から 2 枚のスライドを離します。 

A) ピンセットの先端を２枚のスライドの間に差し込み、ゆるやか

にピンセットを上側または下側に回転させてスライド同士を離

します。 

B) ガスケットスライドのみを容器の底に落としてください。 

注意 Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 中で解体することが重要です。 

 

C) アレイスライドをすばやく取り出し、Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 の入ってい

る洗浄容器 #2 にセットされているラックにそっと差し込みます。 

注意 スライドグラスを扱う時は、バーコード部分かスライドグラスの縁を持つようにします。決してマイクロア

レイに触れることがないように注意してください。アレイが空気に触れる時間を最小限に押さえてください。 

室温放置の影響を検証したデータ 

0 min 5 min

15 min 30 min
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参考手法（推奨） 

ピンセットを用いることにより、洗浄液に手袋を浸さないでアレイを解体することができます。 

使用器具： フラットピンセット 33A  (品番は p.10 参照)  

注意：従来の超精密ピンセット No.T よりも先の丸い部分が大き

いため、丸い部分の半分以上でガラス面を持たないよう注意が必要。 

 

①2 枚のスライドをピンセットで挟み、 ②バーコード側のピンセットを ③両手でスライドガラスを 

 立てた状態でガラス容器１に入れる。 2 枚のスライドガラス間に入れ しっかりはさみ、 

 アレイ面を傷つけないように ガラス容器２中の 

  ガスケットスライドをはがす。 ラックに運ぶ。 

 

 

 

 

 

 

 

 

 

 

 

⑨ 残りのチャンバも同様に解体して、すべてのスライドをラックに差し込みます。全てのスライドで、アレイ面

（Agilent と書かれたほうの面）がラックの中心を向く向きに揃えます。一度に洗浄するアレイは 19 スライ

ドラック（スライドラック小）のときは 5 枚以下にするようにしてください。 

 

 注意 スライドグラスをラックに差し込む際は、洗浄の効率を保つ持つために端は 3 つ以上、スライドグラス間

は 2 つ以上空けてください。19 スライドラックは最大 5 枚、30 スライドラックは最大 8 枚洗浄可能です。 

 

19 スライドラック(Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ109) 30 スライドラック（Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ113） 

  スライドラック小 スライドラック中 

 

 

 

 

 

 

 

 

1 2 3
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すべてのアレイが洗浄容器 #2 内のスライドラックにセットできたら,中程度の回転数（もしくは 350 rpm）で室

温のまま 5 分間 攪拌します。 

 

 注意 スターラー付恒温槽を利用しない場合、Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 1 でスラ

イドガラスを洗浄している間に、ガラス容器 #3 に、37℃で保温してある Agilent Oligo aCGH/ChIP-on-

Chip Wash Buffer ２を注ぎます。（ガラス容器も予め 37℃で保温することを推奨します。） 

 

⑩ スライドラックを 37℃の Agilent Oligo aCGH/ChIP-on-Chip Wash Buffer 2 の入っている洗浄容器 #3

にすばやく移します。中程度の回転数で 1 分間 攪拌します。実験を成功させるために、この洗浄時間を

厳守してください。（２分を超えてはいけません。） 

 

⑪ スターラーの回転速度を最低速まで落とし、回転させたままの状態で、洗浄容器 #3 から。スライドラック

をできるだけ水平に保ったまま、5-10 秒ほどかけてゆっくりと一定の速度で引き上げます。 

 

オゾン除去フィルタによる Cy5 蛍光退色の対策が行われている場合はここで洗浄操作は終了です。P.60 に

すすんでください。 

 

【以下は Stabilization and Drying Solution 使用時のみの操作です。】 

⑫ スライドラックをアセトニトリルの入った洗浄容器 #4 に移します。中程度（もしくは 350 rpm）で室温のま

ま 10 秒間攪拌します。 

  

⑬ スライドラックを Stabilization and Drying Solution の入った洗浄容器 #5 に移します。中程度（もしくは

350 rpm）で室温のまま 30 秒間攪拌します。 

 

⑭ スターラーの回転速度を最低速まで落とし、回転させたままの状態で、スライドラックをできるだけ水平に

保ったまま、スライドラックを 5-10 秒ほどかけてゆっくりと一定の速度でスライドラックを引き上げてくださ

い。スライドラックを溶液から出したり戻したりしないように注意して下さい。スライドラックを取り出すのが

早すぎる場合、スライドガラス上に白い粒子が生じることがあります。その場合には、直ちにスライドラッ

クを Stabilization and Drying Solution 中に沈めて、再度極めてゆっくりかつ一定の速度で取り出してく

ださい。 

この操作でスライドガラスは乾燥しますので、その後ただちにスキャンを行うことができます（窒素ガスに

よる乾燥は必要ありません） 

 

注意 Stabilization and Drying Solution の滴がスライドラック下側のスライドガラスの端に残る場合がありま

すが、オリゴ DNA がプリントしてあるアレイエリア内に液滴がなければ問題ありません。決してスライドを振ら

ないで下さい。スライドガラスのアレイエリア内に滴がついている場合は、すぐにスライドラックを Stabilization 

and Drying Solution に再度浸し、それから再度極めてゆっくりとかつ一定の速度で取り出してください。 

注意 Stabilization and Drying Solution およびアセトニトリルの繰り返し利用回数は 3 回までになります。た

だし繰り返し利用できる回数は Oligo aCGH/ChIP-on-Chip Wash Buffer 2 の持ちこみ量によって異なります。 
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注意 Stabilization and Drying Solution には、オゾン除去剤が含まれていますが、長時間のオゾン暴露によ

りシグナルは退色していきます。オゾン暴露を最小限にするために、洗浄とスキャンは早朝または夕方の遅

い時間に行ってください。大気中のオゾン濃度は日中、特に交通量が多い時間帯に最大になります。Agilent

社のスキャナをお使いいただく場合には、一度にセットするスライドガラスを 10 枚までにしてください。このよう

なスキャニグ操作を行うことで、大気中のオゾン暴露を最小限にすることが可能です。  

 

【Stabilization and Drying Solution の保存】 

 

ヒュームフード（ドラフト）内で、手袋を用いて、Stabilization and Drying Solution を褐色または透明なガラス

容器に移します。液を移した後、少なくとも 30%以上のヘッドスペースがある大きさのガラス容器をお使いくだ

さい。漏斗を使用すると、簡単に溶液を移すことができます。Stabilization and Drying Solution を移した褐色

あるいは透明なガラス容器は、暗所で保存して下さい。Stabilization and Drying Solution は初回使用後、2

回まで、合計 3 回まで繰り返し使用できます。Stabilization and Drying Solution の繰り返し使用を終了した

後は、HPLC 廃液およびフェノール廃棄と同様の方法にて揮発性の溶剤として処分して下さい。 
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10-3. Agilent スキャナを用いたスキャニングと解析 

 

10-3-1. マイクロアレイスライドのスキャン 

環境中のオキシダントがシグナル強度へ与える影響を最小にするために、マイクロアレイスライドをすぐにス

キャンします。 

 

レーザーを安定させるために、スキャンを開始する 20 分前までにスキャナの電源を入れます（SureScan の

場合は直前でも可能）。 

PC を起動した後にスキャナの電源を入れ、スキャナコントロールソフトウェアを立ち上げます。 

スキャナおよびスキャナコントロールソフトウェアのバージョンについては p.15 必要なスキャナおよびソフトウ

ェアを参照してください。 

 

① スキャナコントロールソフトウェアの立ち上げ 

A) デスクトップ上のアジレントスキャナのアイコンをダブルクリックして、ソフトウェアを起動します。 

 （SureScan の場合  ） 

B) スキャンコントロール画面が表示され、スキャナのイニシャライズが始まります。C スキャナはイニシ

ャライズが始まると、メイン画面の下方欄に“Initializing Scanner” というメッセージが表示され、ス

キャナの蓋（Lid）はロックされます。イニシャライズ後、蓋のロックが解除されます。レーザーのウォ

ームアップが終了していない場合は、“Lasers are warming up...” と表示されます。レーザーのウ

ォームアップには、数分から 20 分程度かかります。ウォームアップが完了すると、表示が“Scanner 

ready.” に変わり、スキャン可能な状態になります。 

SureScan で Initialize logger failed とエラーが出た場合は、巻末のトラブルシューティングを参照

してください。 

 

② スライドをスライドホルダにセットします。スライドホルダをセットした際に、数字のバーコード面が見える

ような向きで挿入します。 

B スキャナまたは C スキャナをお使いの場合 

オゾン濃度が 5 ppb 以下の環境で、”Agilent”と記載のある面がスライドホルダの上に向くようにスラ

イドを入れます。オゾンレベルが 5 ppb を超える環境では迅速に Ozone-barrier slide cover をアレイ

の上に載せます（p.61）。 

 

 

 

 

 

 

 

アレイ面 

“Agilent”と記載の面がスライド 

ホルダの上側にくるように挿入 

奥のつめにのせる 

スライドホルダの 

開け方 
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(オプション) Ozone-barrier slide cover [型式 G2505-60550]の使用 

オゾンバリアスライドカバーを使用すると、スキャン中のオゾンによる蛍光色素の退色を抑えることができます。

下図のように、スライドホルダに挿入したアレイスライドに重なるように、(アレイ表面に触れないように注意し

ながら) Ozone-barrier slide cover を置き、スライドホルダのカバーを閉めます。 

 

・スポット面を傷つける恐れがあるので、Ozone-barrier slide cover の

向き（裏表、左右の向き）に気を付けてください。 

・スキャン中の退色のみに有効です。洗浄・乾燥時の退色はオゾンバリ

アスライドカバーのみでは防ぐことはできません。 

・オゾンフリーブースをご利用の場合は、使用する必要はありません。 

 

SureScan をお使いの場合 

 

アレイスライドをスライドホルダに挿入する前に、スライドホルダにほこりや指紋が付いていないことを確認し

てください。もしほこりや指紋が付いている場合は、圧縮空気か柔らかい布で取り除いてください。スライドホ

ルダにひっかき傷や壊れている場所がある、カバーが閉まらない、カバーが動きにくいなどの場合は、他のス

ライドホルダを使用してください。 

 

a. スライドホルダのカバーを開けます。 

b. ’Agilent’と記載の面がスライドホルダの上側になるように、’Agilent’の文字が奥側になるようにス

ライドを載せます。 

c. スライドホルダのカバーを閉めます。閉める際カチッと音がし、固く閉まっていることを確認して下さ

い。 

d. カバーのしまりが緩い場合は他のスライドホルダを使用してください。スライドホルダは 1 台のスキ

ャナに 24 個ついています(足りなくなりましたら購入も可能です。お問い合わせください)。 

 

③ スライドホルダをスキャナのカローセル（SureScan の場合はカセット）にセットします。 

 

注意 アセトニトリルをご利用の場合、アセトニトリルがスライドホルダに付着しないようにご注意下さい。 

アセトニトリルが、スライドホルダを侵します。 

 

④ 複数のスライドグラスをスキャンする場合は、隣り合うスロットにセットしてください。また、Bスキャナ・Cス

キャナ使用時は H と書かれている Home スロットにはセットしないでください。SureScan の場合は、ど

の位置にセットしても構いません。 

① カバーを開けます。 
② スライドを載せます。 

“Agilent”と記載の面がスライ

ドホルダの上側にくるように

挿入 
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また、どちらのタイプのスキャナでもスライドホルダのカバーはきちんと閉めて下さい。完全に閉まってい

ない状態でスキャンを開始すると、スキャナ内でスライドホルダが引っかかってしまい、エンジニアによる

修理が必要となることがあります。 
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⑤ スキャナの設定 

 

C スキャナの場合 

注意：C スキャナには 

Agilent Scan Control Software v8.0 以降  

が必要です 

注意：CGH+SNP マイクロアレイのスキャン 

には C スキャナが必要です。 

 

A) Operator の欄にユーザ名を入力します。 

 

B) Start Slot と End Slot を設定します。 

Start slot: ボックスのドロップダウン ▼ をクリックし、 

最初にスキャンするスロットの番号を選択します。 

End Slot: ボックスのドロップダウン ▼ をクリックし、 

最後にスキャンするスロットの番号を選択します。 

ここで入力したスロットの番号に基づき、スキャンコントロールのメイン画面の表示が変更されます。 

 

C) Profile 欄から Agilent G3_CGH（1x1M、2x400K、4x180K、8x60K の場合）または AgilentHD_CGH 

（1x244K、2x105K、4x44K、8x15K の場合）を選択します。 

スキャン設定が以下の条件になっているか確認します。（フォーマットについては p.14 参照） 

 HD マイクロアレイフォーマット G3 マイクロアレイフォーマット 

Dye channel R+D (red and green) R+D (red and green) 

Scan region Agilent HD (61 x 21.6 mm) Agilent HD (61 x 21.6 mm) 

Scan resolution 5 μm 3 μm 

Tiff file dynamic range 16 bit 16 bit 

Red PMT gain 100% 100% 

Green PMT gain 100% 100% 

XDR <No XDR> <No XDR> 

 

D) Output Path Browse: をクリックして保存先を 

設定します。 

 

E) Scanner Status が Scanner Ready になっている 

ことを確認します 

 

F) メイン画面の右下「Scan Slot m-n」をクリックします。 

（m は最初のスライドが位置するスロット番号、 

n は最後のスライドが位置するスロット番号） 

 

Profile 欄 

Start Slot, End Slot 

Output Path 
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B スキャナの場合 

注意：B スキャナで Agilent CGH マイク

ロ ア レ イ 1x244K 、 2x105K 、 4x44K 、

8x15K フォーマットをスキャンする場合、

Agilent Scan Control Software v7.0 

推奨。 

 

 

 

A) Start Slot と End Slot を設定します。 

Start slot: ボックスのドロップダウン ▼ をクリックし、 

最初にスキャンするスロットの番号を選択します。 

End Slot: ボックスのドロップダウン ▼ をクリックし、 

最後にスキャンするスロットの番号を選択します。 

ここで入力したスロットの番号に基づき、スキャンコント

ロールのメイン画面の表示が変更されます。 

 

B) eXtended Dynamic range のチェックボックスを外します。（上図参照） 

C) スキャン設定が以下の条件になっているか確認します。（デフォルト条件の設定→p.61） 

 HD マイクロアレイフォーマット 

Scan region Scan Area (61 x 21.6 mm) 

Scan resolution (μm) 5 

Dye Channel Red & Green 

Red PMT 100% 

Green PMT 100% 

 

なっていない場合、Edit Slot Values>>（上図参照）をクリックしてメイン画面を拡張し、設定を所定の値に

変更します。 

 

a. 設定を変更するスライドをテーブル内で

選択します(複数枚選択できます)。 

選択されると青くハイライトされます。 

b. 各項目の設定を変更し、Set Values を 

クリックします（Set values をクリックしな

いと変更が反映されません）。右図はス

キャン解像度を変更する例です。 

c. テーブル内の設定値が変更されたこと

を確認してください。 

 

D) メイン画面の左下にある Scanner status が Scanner Ready になっている事を確認してください。 

E) すべて設定が終了したら、メイン画面上「Scan Slot m-n」をクリックします（スキャンが開始されます）。 

eXtended Dynamic range の

チェックボックスを外す 

c. Set Value をクリック 

a.変更するスライドを選択 

b. 変更内容を設定 

Edit Slot Values>> 
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参考：スキャンのデフォルト設定変更法 

-------------------------------------------------- 

（ 1) ScanContorol を立ち上げます ） 

 2) Settings>Modify Default Settings を選択します 

 3) 表示された”Default Setting”ボックにて、変更を行います。 

    例：ファイル名自動作成の設定 

・ Prefix 1 : Instrument Serial Number 

・ Prefix 2 : Array barcode 

 

 4) OK ボタンを押してボックスを閉じます 
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SureScan マイクロアレイスキャナの場合 

 

注意 ドアを手で開けたり、カセットを手で動かしたりしないでください。エラーが発生します。 

エラーが発生したら、スキャナコントロールソフトウェアを再起動する必要があります。 

 

A) 初期化が終了すると、ファンクションボ

タンのOpen Doorボタンがアクティブに

なります。クリックし、カセットにスライド

をセットします。スライドがセットされて

いるカセットは青色で表示されます。ま

た、各パラメータの編集ができるように

なります。 

 

 

 

 

B) Scan Protocolからプロトコルファイルを選

択します。 

・ 1x1M、2x400K、4x180K、8x60Kの場合

Agilent G3_CGH 

・ 1x244K、2x105K、4x44K、8x15Kの場合 

AgilentHD_CGH 

 

ウィンドウ右側のセッティングペインでスキャン設定（p.59参照）を確認してください。変更する必要

があれば個別にプルダウンメニューで変更できます。 

 

C) 必要があればデータの保存先を変更します。※D drive内のフォルダを指定してください。 

 

 

 

D) ステータスバーでScannerのステータスがReadyであることを確認し、ファンクションボタンのAll to 

Queueボタンをクリックします。 

 

E) ファンクションボタンのStart Scanボタンをクリックするとスキャンを開始します。 

 

F) スキャンが終了し、Open Doorボタンがアクティブになったら、クリックしスライドホルダを取り出し、

Close Doorボタンをクリックしてドアを閉じます。 

 

G) コントロールソフトを閉じた後にスキャナおよびPCの電源を消してください。 

スライドがセットされると

青色で表示されます。 

スロットステータス 

インジケータ 

ファンクションボタン 

メニューバー 

スロットテーブル 

ログ 

セッティングペイン 

起動画面と各項目の名前 

プロトコル 

ファイルの選択 
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10-3-2. マイクロアレイ画像データの解析 

 

スキャンが完了したあと、数値化と解析を行います。 

数値化のソフトウェア Feature Extraction は、スキャンで得られた画像データ（拡張子 .tif）からデータを

抽出し、log ratioに変換します。得られたLog Ratioの値をもとに解析を行い、Aberrationを検出します。 

 

アジレントは Feature Extraction ソフトウェアを、単独のプログラムとして、また CytoGenomics に統合さ

れている内容の一部（Windows 版のみ）として提供いたしております。 

(CytoGenomics ソフトウェアは生物種としてヒトのみに対応いたしております。) 

Feature Extraction ソフトウェアによる数値化につきましては、p.72 以降をご覧ください。 

 

・ ヒト生物種の場合、Agilent CytoGenomics の Window 版をお使いいただけます。数値化と解析プ

ロセスの間に、CytoGenomics は数値化データファイルと QC・Aberration レポートを作成します。 

・ Mac コンピュータ上で Agilent CytoGenomics をお使いになる場合は、まず Windows 上で

Feature Extraction を用いて数値化データを抽出します。Feature Extraction ソフトウェアは Mac コ

ンピュータ上では動作いたしません。 

・ ヒト以外の生物種の場合、Feature Extraction（Windows にのみ対応） にて数値化データを抽出

し、そのあと Agilent Genomic Workbench で解析を行ってください。 

 

高品質のサンプルを用いた場合のマイクロアレイの QC メトリクス 

 

これらのメトリクスは高品質の DNA サンプルを、本プロトコルに記載されている標準実験プロトコルを用

いて CGH マイクロアレイで解析した場合に適応可能です。これらのメトリクスは、Feature Extraction 

（単体のソフト、もしくは Agilent CytoGenomics ソフトウェアに含まれているもの）で作成される QC レポ

ート上に記載されています。アッセイ中のマイクロアレイデータセットにおけるデータの質の確認に使用

いただけます。これらの値から実験上のエラーの可能性も示唆されることがあります。マイクロアレイフォ

ーマット（1-pack、2-pack、4-pack、8-pack）・生物サンプルソース・使用ゲノム DNA の質・実験過程・ス

キャナの感度・画像解析を含む多くの要素がこれらのメトリクスの値に影響します。下に示しました数値

のガイドラインは Ailent が本プロトコルでサンプルを解析して得られた閾値です。 

 

CGH+SNP マイクロアレイで高い SNP call rate と accuracy を得るには DLR Spread が <0.2 であることが

大切です。 
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• FE10.5 QC report 

 

   

  

CGH QC Metrics 
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QC Reportは、以下の項目を示します。 

（各項目の詳細は、Help > Reference Guide で確認することができます。） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※ AnyColorPrcntFeatNonUnifOL: The percentage of features that are feature non-uniformity 

outliers in either channel  

DerivativeLR_Spread: measures the standard deviation of the probe-to-probe difference of the log 

ratios. This is a metric used in CGH experiments where differences in the log ratios are small on 

average. A smaller standard deviation here indicates less noise in the biological signals. 

g(r)Repro: median CV% of BGSubSignal of the NonControl replicated sequences 

g(r)_BGNoise: standard deviation of negative control probes after rejecting feature nonuniform 

outliers, saturated features, and feature population outliers 

g(r)_Signal2Noise: Signal Intensity divided by BGNoise 

g(r)_SignalIntensity: median background-subtracted signal after rejecting nonuniform outliers and 

saturated features. 

  

FE9.5 QC report 

・ QC Report Header 

・ Spot Finding of Four Corners 

・ Outlier Stats 

・ Spatial Distribution of All Outliers 

・ Net Signal Statistics 

・ Negative Control Stats 

・ Plot of Background-Corrected Signals 

・ Local Background Inliers 

・ Foreground Surface Fit 

・ Reproducibility Statistics 

(%CV Replicated Probes) 

・ Spatial Distribution of  

Up- and Down-Regulated Features 

・ Plot of LogRatio vs Average Log Signal 

FE10.5 QC report 

・ QC Report Header 

・ Spot Finding of Four Corners 

・ Spatial Distribution of All Outliers 

・ Outlier Stats 

・ Spatial Distribution of Significantly  

Up-Regulated and Down-Regulated Features 

(Positive and Negative Log Ratios) 

・ QC reports with metric sets※ 

・ Histogram of Signals Plot  

・ Plot of Background-Corrected Signals 
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11．Feature Extraction による tif 画像（スキャン画像データ）の確認 

 

実習では、アジレントマイクロアレイスキャナーを使用した画像化と、イメージの簡単な確認法をご紹介します。

より詳細については、スキャナに付属の日本語簡易版マニュアルまたは英語版イメージアナリシス・マニュア

ルをご覧ください。 

 

【Feature Extraction ソフトウェアでスキャンした画像ファイルを開く方法】 

・ tifイメージファイルをデスクトップのFeature Extractionショートカット  にドラッグ＆ドロップ。 

・ Feature Extractionソフトウェアを起動し、File > Open >Imageをクリックし、表示させるtifデータを選択 

  

 

①バックグランドのむらの確認 

ログスケール表示によりバックグランドのむらを確認します。ログスケール・リニアスケール切り替えボタンをク

リックします（  ） 

 リニアスケール ログスケール 

 

 

②画像の一部を切り取る（クロップモードの ON/OFF） 

画面のクロップモードボタン （ ）をクリックすることで ON/OFF の切り替えができます。クロップモードが ON

の場合、ポインタの横にひし形のマークが表示されます。イメージをクロップすると新しいウィンドウで切り取っ

た画像が表示されます。OFF の場合、クロップ時にその大きさに合わせてウィンドウが拡大表示されます。 

 

③画像の拡大・縮小 

画面の をクリックすることで画像を拡大・縮小することができます。②のクロップ機能との組み合わ

せにより、見たい領域の拡大・縮小がよりスムーズになります。 
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④ラインプロット 

異常スポットやバックグラウンドなど、特定の領域のシグナルをラインプロットにより確認することができます。 

 

 

 

 

 

 

 

 

 

ラインプロットを見たい位置（上の図の場合、青線上のどこでも構いません）にポインタを合わせてダブル左ク

リックします。縦軸方向でラインプロットを作成するときはライン上をダブル右クリックします。 

 

④イメージデータのスケールの確認 

両チャンネルのデータレンジを確認します。    をクリックします。イメージデータ全体に対し、１％から９９％

の設定（デフォルト）における最大値・最小値を確認します。 

 

＜注意＞ここでの確認はイメージデータ全体に対するものとなり

ます（スポット以外のエリアも含みます）。 

スポットレベルで確認する（例：コントロールスポットを除く全遺伝

子スポットに対してデータスケールを確認する）ためには、スポッ

ト定量が必要になりますので御注意ください。 

 

 

 

⑤ カラースワップの確認 

色素交換を行ったアレイがある場合、 

２枚のアレイイメージを比べて大まかな 

スワップ傾向が見られるかを調べます。 

 

 

 

この傾向を適正に見る為に、カラーレンジの設定を１％から９９％の 

設定（デフォルト）にしてください。 

設定に応じて、Cy3 の発現量が多い場合に緑色、Cy5 の発現が多い場 

合に赤色になるように表示されます。 
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12． Feature Extraction ソフトウェアによる数値化 

 

【注意】 

 

・ CGH+SNP マイクロアレイのスキャンデータ（.tif）の数値化には Feature Extraction ソフトウェア v10.10

以降が必要です。 

 

・ Agilent C スキャナでスキャンした Agilent CGH マクロアレイ TIFF 画像の数値化には Feature 

Extraction ソフトウェア v10.5 以降が必要です。また、GenePix 4000B スキャナでスキャンされた Agilent 

CGH マイクロアレイの TIFF 画像を Feature Extraction v10.5 以降で数値化することができません。 

 

・ Agilent B スキャナおよび GenePix 4000B にてスキャンした Feature Extraction ソフトウェア v9.5

以降が必要です。 

 

【数値化の原理】 

 

数値化により、スポットのシグナル強度、ローカルバックグランドのシグナル強度などが算出されます。Agilent

スキャナに付属する Feature Extraction ソフトウェアはこれに加えてバックグランドの引き算、色素補正を行

い、最終的な２サンプルの発現比（LogRatio）および統計処理されたエラー値と P 値を決定します。 

 

上記のスポット解析を行った数値データを用いて、高度なデータ解析を別のソフトウェアで行います。一番身

近なものではエクセルが挙げられますが、エクセルはアレイごとの結果を解析するのには適していますが、複

数アレイの結果の比較には適していません。データ解析を行うソフトウェアは数多く製品化されていますが、

本トレーニングではエクセルで基本的な解析を行い数値化のアウトプットデータを理解した上で、Agilent 

Genomic Workbench を使ったデモを行い、さらに生物学的意義を付け加えていきます。 

 

 Agilent Feature Extraction  Agilent CGH Analytics など 

 

スポットの数値化は以下の手順で行われます。 

 

① スポットのシグナル強度計算 

② バックグランドのシグナル強度計算 

③ バックグランド補正 ※１ 

④ 色素補正 ※２ 

⑤ 発現差計算 
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※１ バックグランド補正 

 

 アレイのイメージ結果によって、以下の減算法が挙げられます。 

• ローカルバックグランド 

• 全ローカルバックグランドの平均値 

• ネガティブコントロールのバックグランド 

• アレイイメージの最低シグナル値（スポット、バックグランド含む） 

• スポットの最低シグナル値 

 

ローカルバックグランドはスポットの周囲でプローブがスポットされていない部分になります。 

例：ローカルバックグラウンドの使用 

  

また、以下の補正法が挙げられます。 

• Spatial Detrend 

• Global Adjustment 

現在の Agilent CGH マイクロアレイではネガティブコントロール値を Surface fit することに基づく Spatial 

Detrend が採用されています。 

フィーチャのシグナル raw data 平均値

- ピクセルOutlier 計算

- フィーチャUniformity Outlier 計算

- フィーチャPopulation Outlier 計算

gBGUsed バックグランドのシグナル値

- ローカルバックグランド

- グローバルバックグランド

- ピクセル Outlier 計算

- バックグランド Uniformity Outlier 計算

- バックグランド Population Outlier 計算

rBGUsed

gBGSubSignal フィーチャのシグナル raw data 値からバックグランドを引き算rBGSubSignal

gDyeNormSignal rDyeNormSignal 色素補正

- グローバル補正

- コントロール補正

gProcessedSignal rProcessedSignal Surrogate 値の適用
色素補正後シグナル値が 0 以下になった時に使う代替値

→バックグランドの標準偏差値

gMeanSignal rMeanSignal

LogRatio

フィーチャのシグナル raw data 平均値

- ピクセルOutlier 計算

- フィーチャUniformity Outlier 計算

- フィーチャPopulation Outlier 計算

gBGUsed バックグランドのシグナル値

- ローカルバックグランド

- グローバルバックグランド

- ピクセル Outlier 計算

- バックグランド Uniformity Outlier 計算

- バックグランド Population Outlier 計算

rBGUsed

gBGSubSignal フィーチャのシグナル raw data 値からバックグランドを引き算rBGSubSignal

gDyeNormSignal rDyeNormSignal 色素補正

- グローバル補正

- コントロール補正

gProcessedSignal rProcessedSignal Surrogate 値の適用
色素補正後シグナル値が 0 以下になった時に使う代替値

→バックグランドの標準偏差値

gMeanSignal rMeanSignal

LogRatio
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※２ 色素補正 

 

Cyanine3、Cyanine5 色素のラベル化 DNA への取り込み率の違い(色素バイアス)を解消するために色素補

正を行います。色素補正は次の２つのステップから成ります。 

① 色素補正に使うスポットの選択 

② 色素補正法の選択 

 

① 色素補正に使うスポットの選択には以下の４方法があります。 

• Use all probes: フラグがたっていない全てのスポットで補正 

Up、または Down と判定されるスポットの数が少ない場合、または Up、Down と判定されるス

ポットの数が同じぐらいであると予想される場合はグローバル補正（全スポット）を使います。 

• Use Rank Consistent Probes: Rank Consistency 法を使ってスポットを選択 

基本的にはグローバル補正ですが、全スポットを使用するのではなく、スポットのなかでも

Cyanine3 と Cyanine5 が central tendency に載っているスポットを選択して、補正に使用し

ます。選択されるスポットはアレイによって異なります。 

• Use List of Normalization Genes 

実験系で変動がないとわかっているプローブセットがある場合は、それらに関して補正を使い

ます。 

• Use Rank Consistent List of Normalization Genes 

ユーザ定義による”Normalization Genes”のなかで Rank Consistency 法を使ってスポットを

選択 

 

② 色素補正法には大きく分けて以下の２方法があります。 

• Linear 法 

バックグランドをひいたシグナル強度に色素バイアス係数をかけて計算します。 

• Linear&LOWESS 法（Locally Weighted Linear Regression） 

Linear 法を適応した後、シグナル強度ごとに色素バイアス係数を計算します。 

• LOWESS 法 

シグナル強度ごとに色素バイアス係数を計算します。 

 

現在の Agilent CGH マイクロアレイでは Use Rank Consistent Probes により選抜された補正プローブをもと

に Linear 法により色素補正が行われています。 
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12-1. Feature Extraction 画面（ウインドウの構成）の説明 

 

Feature Extraction Ver.8 以降の画面は、Project Work Window（スポットの数値化の画面）と Image Work 

Window（イメージ確認の画面）があります。 

 

 

Project Work Window が表示されていない場合は 

File > New > Standard Project を選択すると表示されます 

 

 

Grid Template Browser や FE Protocol Browser が表示されていない場合は 

View > Grid Template Browser および FE Protocol Browser の左を選択します。  

 

 

Image Work Window は、tif イメージファイル Feature Extraction で表示させるときに、画面に表示されます。   

Project 

Explorer 

Pane 
Project 

Work Window 

Grid Template Browser 

 

FE Protocol Browser 

 

Image Work Window 
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• Grid Template Browser 

インストール済みの Design File または Grid File のリスト 

 

Grid Template Browser内に、新規Design Fileを加える場合は 

Grid Template Browser Pane 上で右クリック→Add…を選択後、目的の Design File を選択して下さい。 

（または、Tools > Grid Template > Add…を選択後、目的の Design File を選択） 

 

※各 Design File に Default の Protocol を設定する方法 

Grid Template Browser Pane に格納されている目的の Design File を選択します。左ダブルクリック（ま

たは、Tools > Grid Template > Properties を選択）後、FE Grid Template Properties の window が開き

ます。FE Grid Template Properties window 内の Other に含まれる Default Protocol、Default One 

Color Protocol から適切な Protocol を選択します。 

 

 

• FE Protocol Browser 

各数値化ステップのアルゴリズムのパラメータを含む、アプリケーションごとのファイル。ダブルクリックで

開いて変更・保存可能。 

 

FE Protocol Browser内に、新規Protocolを加える場合 

FE Protocol Browser Pane 上で右クリック → Import…を選択後、目的の Protocol を選択して下さい。 

（または、Tools > FE Protocol > Import…を選択後、目的の Protocol を選択） 

 

※Agilent カタログアレイの Design File、Agilent が推奨している Default 設定の Protocol は、Feature 

Extraction 9.5 をインストールする際に、自動的にインストールされます。しかしながら、最新版の Design File、

Agilentが推奨している Default 設定のProtocolは更新される場合があります。最新版 Design File、Protocol

は後述の弊社 Web サイト Sure Design からダウンロード可能です（p.85）。 
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12-2. Agilent Feature Extraction ソフトウェアによる数値化 

 

Step 1— Feature Extraction ソフトウェアの起動 

Project Work Windowを以下の方法で立ち上げて、スポットの数値化を行っていきます。 

• デスクトップのFeature Extractionショートカット  をダブルクリックします。このショートカットは

Feature Extraction ソフトウェアをインストールした時に自動的に作成されます。 

• Start>Programs>Agilent-Life Sciences>Feature Extraction からソフトウェアを開始させます。 

 

Step 2—FE projectへ数値化するイメージ(.tif)を追加 

1. ツールバーにあるAdd New Extraction Set(s)のアイコン   をクリックします。あるいは、Project 

Explorer内で、右クリックをします。そして、Add Extraction…を選択します。 

 

2. tif.ファイルを選択して、Openをクリックします。複数のファイルを指定するときには、ShiftまたはCtrlキー

を押しながら選択します。 

  ※XDR設定でスキャンしたtif画像は、2種類（1stおよび2nd）のScan Fileがイメージファイルとして認識さ

れます。その際、1stおよび2ndのScan Fileが、同一フォルダ内に存在する必要があります。 

 

3. Project Explorer内のProject下の階層にExtraction Setが、さらにExtraction Set下の階層にImage File、

Grid Template（あるいはGrid File）、Protocolが現われることを確認して下さい。必要に応じて、適切な

Grid TemplateとProtocolを選択してください。 

 

 

 

 

 

 

 

 

 

 

Project ：Feature Extraction の Run 設定全体をまとめた情報です。1 つ以上の Extraction Set から構成さ

れています。 

Extraction Set ：解析する tif 画像ごとに作成されます。Image File、Grid Template (Grid File)、Protocol か

ら構成されています。 

Image File ：解析対象のマイクロアレイ画像のことです。 

Grid Template (Grid File) ：Grid 情報です。Agilent アレイのお客様は、Design File を意味します。 

Protocol ：イメージの数値化の際、適用する解析アルゴリズムの設定です。 

 

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project
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Step 3—Project PropertiesおよびExtraction Set Configurationタブシートでの設定および確認 

 

1. Extraction Set Configuration タブシートの確認をします。 

・ Extraction Set Configurationタブシートを選択。 

 

 

 

 

・ Extraction Setで用いる構成（イメージ、Design File、Protocolなど）を設定、確認します。 

 ※Protocol は 

Feature Extraction v 9.1の場合：CGH-v4_91 

Feature Extraction v 9.5の場合：CGH-v4_95_日付 

Feature Extraction v 10.5の場合：CGH_105_日付 

Feature Extraction v 10.7の場合：CGH_107_日付 

Feature Extraction v 11.5の場合：CGH_1105_日付 

Feature Extraction v 12.0の場合：CGH_1200_日付 

を選択して下さい。最新のDesign FileおよびProtocol入手方法はp.80, 81をご参照ください。 

  プルダウンメニューに適したDesign Fileがない場合、まずDesign FileをGrid Template Browserに追加し

て（p.76）再度プルダウンメニューから選択してください。最新のDesign FileはeArrayから入手可能です

（p.85）。もしくはGrid Template Browserの枠内で右クリックをして、Online Updateを選択することでも可能

です（アップデート完了までに若干時間がかかります）。 

 

2. Project Properties タブシートでの設定確認、および設定を行います。 

・ Project Propertiesタブシートを選択する、あるいは、Project Explorer内の解析に用いるProjectをダ

ブルクリック。 

・ Projectの設定を確認、変更をします（解析結果ファイルのOutputフォルダの設定、結果としてOutput

するファイル種類の設定など）。 

 

Project PropertiesタブシートProject Propertiesタブシート

Extraction Set Configurationタブシート 
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• 出力方法の設定 

  出力方法は以下の4つから選択することができます。 

None （出力しない） 

Local file only （ハードディスクに出力する） 

FTP send only （外部にファイルを転送する） 

Both local file and FTP send （両方に出力する） 

 

本実習では、TEXT、Visual Results、QC Reportの結果を出力します。これらの項目の設定を、Local 

file onlyと選択します。また、それ以外の項目（MAGE、JPEG、Grid）は、Noneを選択します。 

 

• 出力ファイルの設定 

MAGE アレイの結果をXML形式で出力。解析にロゼッタ社のリゾルバー/ルミネーター

を使用する場合、Array Expressにデータを転送する場合などに必要。 

JPEG 各アレイ画像をJPEG形式で出力。この画像ファイルからは数値化はできないの

で注意。 

TEXT  アレイの結果をタブ区切りテキスト形式で出力。解析にGeneSpring、エクセル

などを使用する場合に必要。 

※TEXTファイルのOutput設定は、以下のOutput Package設定が可能です。 

Full ：数値化項目全ての結果を出力します。 

Compact ：数値化項目の一部（通常、データ解析に用いると考えられる項目）

の結果を出力します。Fullに比べ、約1/3のファイルサイズとなります。 

GeneSpring, DNA Analyticsを使用する場合はCompact推奨。 

  Visual Results 数値化結果のTIFF画像へ重ね描きするのに必要な.shpファイルを出力。 

Grid グリッド合わせの詳細（スポット位置情報など）をCSV形式で出力。 

  QC report 実験の成否をチェックするための項目を含んだレポートを出力。 

※QC reportはPDFファイルあるいはHTMLファイルで出力できます。 

PDFファイルは”Local PDF file only”を、HTMLファイルは””Local HTML file 

only”を選択してください。HTMLファイルの場合は数値化後、必ず

QCReport_Graphsというフォルダと同じフォルダにHTMLファイルを保存してく

ださい。 

 

 

3. 設定を確認したら、Project の保存を行います。 

・ File > Save As後、Save Asのダイアログ画面が出てきますので、FE Project Data Files (.fep)ファイ

ルを保存するための適切なフォルダを選択および作成して下さい。 

・ フォルダ指定後、名前を付けて保存して下さい。 
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Step 4—Feature Extraction Projectをスタート 

 

Project > Start Extractingを選択すると、Projectがスタートします。 

スタート後、Summary ReportタブとRunning Monitorが現われます。 

 

 

 

 

 

 

 

進行状況は、Running Monitorに表示されます。Project終了後、Summary Reportタブを選択していると、

Project Work Windowに、Project終了を示すSummaryが現われます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※4x44K、4x180K フォーマットの出力結果は、ファイル名末尾 ”…_1” ～ “…_4” の4つのデータが得られ

ます。 

8x60K、8x15K フォーマットの出力結果は、ファイル名末尾”…_1_1” ～ “…2_4” の8つのデータが得られ

ます。 

それぞれ、下図の位置のアレイに対応しています(バーコードラベルを左側、Inactiveサイトが手前の状態)。 

 

 

 

 

 

Summary ReportタブシートSummary Reportタブシート

 

Running MonitorRunning Monitor

 

Project 終了後Project 終了後

1 2 3 41 2 3 4
1_1 1_2 1_3 1_4

2_1 2_2 2_3 2_4

1_1 1_2 1_3 1_41_1 1_2 1_3 1_4

2_1 2_2 2_3 2_42_1 2_2 2_3 2_4
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Step 5—QC Reportの確認 

 

1. 出力された結果ファイルに、”pdf形式のQCReportファイル”があることを確認して下さい。 

2. ”pdf形式のQCReportファイル”を開いて下さい。QC Reportを確認することができます。 

 

Step 6―Visual Resultの確認 

 

Step3で選択したVisual Resultファイルを使ってフラグ等の確認をします。 

1. Feature Extraction内に、画像（拡張子 .tifのデータ）を表示させます。 

2. メニューバーのFeature Extraction > Load Visual Resultを選択します。 

3. 該当するVisual Resultファイル（.shp）を選択します。このとき表示させている画像に対応するファイルを

選択してください。 

4. 画像にVisual Resultが重ね描きされます。 

5. クロップモードやズームイン機能、ログスケール表示機能を使って表示を調節します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. View > Extraction Results からVisual Resultsの表示法を選択できます。 

 

 

 

 

 

     View outliers onlyにチェックを入れた状態 

 

Help > Feature Extraction Output Quick Referenceで各リングの色が示すアウトライヤーを確認できます。 
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12-3. Feature Extracation の結果解析 

  

サンプル間の発現差を求めるもっとも単純な方法は、 Cyanine3 と Cyanine5 の色素強度の比

(FoldChange)になりますが、この方法では以下の図に示したように、Up と Down のスケールが非対称にな

ってしまいます。コンピュータを用いたデータ解析を進めるためには適切ではありません。 

 

 そこで一般的に、Up と Down が対称なスケールになるように、色素強度比の対数(LogRatio)が計算されて

います。 

 

 フィーチャエクストラクションでは、LogRatio として底が 10 の対数(log10)が用いられています。 

 

 

 

 

 

 

 

 

Cy3

Cy5

Cy3

Cy5
分数

10 2 3… ∞

UpDown

10 2 3… ∞

UpDown

Ratio:　UpとDown非対称なスケール

Log Ratio:UpとDown対称なスケール

0-2 -1

UpDown

1 2

Log Ratio:UpとDown対称なスケール

0-2 -1

UpDown

1 20-2 -1

UpDown

1 2

LogRatio : log10

Cyanine3色素強度

Cyanine5色素強度
LogRatio : log10

Cyanine3色素強度

Cyanine5色素強度
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12-4. Feature Extraction 由来のフラグ 

 

• コントロールスポットの排除： ControlType→０にします。 

Agilent コントロールは１または-１、SNP プローブは-15000 

• サチュレーションのフラグ： gIsSaturated、rIsSaturated 

 サチュレーションしたスポットは１、していないスポットは０で表示されています。 

• 各種フラグ： 

① スポットのフラグ gIsFeatNonUnifOL、gIsFeatPopnOL 

rIsFeatNonUnifOL、rIsFeatPopnOL 

② バックグランドのフラグ gIsBGNonUnifOL、gIsBGPopnOL 

rIsBGNonUnifOL、rIsBGPopnOL 

- NonUnifOL は各スポット(バックグランド)内のむら、均一性をみた項目です（１がフラグ、

０がフラグのたっていないスポット）。 

- PopnOL はあるプローブが複数アレイにプリントされている場合、それらのプローブスポ

ット間で均一性があるかをみる項目です（１がフラグ、０がフラグのたっていないスポット）。 

• バックグランドと有意差がないシグナルスポットのフラグ： 

    両側 t 検定により有意差判定を行います。 

gIsPosAndSignif、rIsPosAndSignif 

 シグナルが有意である場合は１、差がない場合は０で表示されています。 

• ある閾値よりも低いシグナルスポットのフラグ： 

     BGSubSignal の値が、バックグランドの標準偏差*を各アレイフォーマットの最適値倍(2.6 あ

るいは 13xBGSD：低密度フォーマットは 2.6、高密度フォーマットは 13 が Default)した値よ

りも大きいか小さいか、で判定を行います。 

 *標準偏差は、1)低密度フォーマット：ピクセルレベルのばらつきを考慮した値、2)高密度フォ

ーマット：エラーモデルから算出された値を用いております。 

gIsWellAboveBG、gIsWellAboveBG 

(このクライテリアよりもシグナルが高い場合は１、低い場合は０で表示されています)。 

gIsPosAndSignif、rIsPosAndSignifよりもクライテリアが高くなり、カットオフされる低シグ

ナルのスポット数が多くなります。 
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13． マイクロアレイのレイアウト・デザインファイル 

 

デザインファイルには、アレイの各プローブの位置情報（レイアウト）やアノテーション情報が含まれておりま

す。このデザインファイルは、アジレント社製 DNA マイクロアレイスキャナで読み取った向きを基準として作成

されております。アジレント社のスキャナはアレイ面を裏側（Back side）から、またバーコードを左位置で読み

取るので、ほとんどの他社製品のスキャナで読み取ったイメージと向きが異なります。数値化データとプロー

ブ情報を組み合わせる際には、お使いのスキャナの読み取り方向にあわせて並び替えたデザインファイルを

お選び頂く必要があります。並び変えたデザインも Sure Design からダウンロードいただけますので、次の点

をよくご確認の上、適切なデザインファイルをお使いください。 

 

1) アレイの表側 (front side)スキャンしているか。(Agilentの文字がある側が表側) 

2) 得られたイメージ画像が、スライドグラスを横方向（landscape）にスキャンしたものか。縦方向（portrait）

にスキャンしたものか。バーコードが得られたイメージに対して、上下左右のどこに位置しているかでご判

断ください。 

 

Design File名には、Design ID (アレイの種類を示します)とファイル更新日の情報が含まれております。              

Design File名の例：014693_D_20070207 

 Design ID 更新日 

 

なお最新のデザインファイルは Sure Design から入手可能です。 

 

 

  

GenePix4000B のスキャンの向き（バーコード：bottom、 

アレイ面：Front side、Scan: Portrait） 
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14．SureDesign 

 

最新のデザインファイルは SureDesign から入手可能です。 

• SureDesign 紹介サイト http://www.chem-agilent.com/contents.php?id=1002474 

SureDesign の登録方法やデザインファイルダウンロード方法などのマニュアルダウンロードサイト 

 

  

• Sure Design ログイン  https://earray.chem.agilent.com/suredesign/ 

 

 

 

 

 

  

ログインサイト 

デザインファイル等のダウンロード方法 

SureDesign の登録方法 

http://www.chem-agilent.com/contents.php?id=1002474
https://earray.chem.agilent.com/suredesign/
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15. Feature Extraction 用 Protocol のダウンロードサイト 

 

弊社スポット数値化ソフトウェア、Feature Extraction によるスポットの数値化を行う際、イメージの数値化に

適用する解析アルゴリズムを設定した Protocol ファイルが必要です。 

Agilent が推奨している Default 設定の Protocol ファイルは、下記のサイトからダウンロードが可能です。 

 

http://www.genomics.agilent.com/article.jsp?pageId=2037 

 

 

 

※ 2015 年 10 月現在、上記の Protocol のダウンロードが可能です。 

※ プロトコルファイルは、最新のものではなく、お使いの Feature Extraction Software と一

致したバージョンをお使い下さい。 

※ 各 Protocol の詳細は、Protocol Use のリンク先をご参照下さい。 

 

http://www.genomics.agilent.com/article.jsp?pageId=2037
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16． Agilent 社の DNA マイクロアレイサポート用ホームページ 

 

 Agilent 社の DNA マイクロアレイサポート用ホームページでは、上記のほかにも新製品や最新プロトコル、

アプリケーションノートなど様々情報を掲載しております。 

 

 

 

 

 

 

 

 

 

  

  

http://www.chem-agilent.com/contents.php?id=23129 



アレイ CGH (aCGH) プロトコル操作実習テキスト 88 

17．Secure Fit マイクロアレイスライドボックスの開け方 

 

マイクロアレイスライドは専用のスライドボックスで納品されます。ここではスライドグラスの取り出し方を紹介

します。 

 

1．写真のようにはさみを使って真空状態のフォイルを開封し、スライドボックスを取り出します。 

真空のフォイルを開封した後、未使用のスライドグラスはスライドボックスに入れ遮光し室温で、真空デシケー

タか窒素パージしたボックスで保管します。 

 

2．スライドボックスを平らな場所に置きます。ふたを開ける前に、片手で箱のふたを抑えながら箱側面のシー

ルテープをカッターなどで切ります。 

 

 

 

 

 

 

3．片方の手で、スライドボックスの箱部分の側面のくぼみをしっかりと持ちます。 

 

 

 

 

 

 

 

 

 

4．もう片方の手でふたを持ち静かに持ち上げます。 
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18．トラブルシューティング 

 

◼ OD260/230、OD260/280 の値が低い 

OD260/230 の値が低い場合、塩や有機溶媒などが混入している可能性があります。OD260/280 の値が

低い場合、タンパク質の混入の可能性があります。いずれの場合にも Specific activity が低くなることがあ

ります（specific activity については p.41 参照）。 

 

推奨操作 

• DNA を Qiagen DNeasy プロトコルで再精製する（p.20~参照）。この再精製操作には Proteinase 

K 処理も含まれます。 

• Phenol/chloroform 法による DNA 抽出が必須の場合、有機層の表面の近くを回収しないよう気を

つけてください。 

Phenol は 270-275nm で最大吸光度を示します。DNA の定量に用いられる 260nm に近いことよ

り、Phenol の混入から DNA の品質が高く見積もられることが起こり得ます。 

• Spectrophotometer で測定するとき、正しい buffer でキャリブレーションしてください。 

 

◼ DNA に RNA が残存している 

ラベル化に用いる DNA の量は experiment と reference を同じにすることが重要です。RNA の吸収波長

は DNA と同じであるため、RNA が混入しているサンプルの DNA 濃度を UV で正しく測定することは困難

です。 

 

推奨操作 

• DNA を Qiagen DNeasy プロトコルで再精製する（p.20~参照）。この再精製操作には RNase A

処理も含まれます。 

 

◼ DNA が分解している 

1～1.5 %アガロースゲル上で、分解していないゲノム DNA はコンパクトな、高分子量のバンドとして検出さ

れます （低分子量領域へのスメアバンドは検出されない）。DNA の分解はラベル化に影響します。 

 

推奨操作 

• DNA を 1～1.5%アガロースゲル電気泳動で確認します。DNA が分解している場合は Qiagen 

DNeasy プロトコルで再精製してください（p.20~参照）。 

• 制限酵素反応を省く操作の場合、98℃で加熱しすぎないようにします。誤った温度や加熱時間、蒸

発（ふたが加熱されるサーマルサイクラーの使用推奨）に注意してください。熱により断片化を行っ

たゲノム DNA は 1000～3000 bp 程度の長さになります。 

◼ ホルマリン固定パラフィン包埋（FFPE）試料を使用する場合、Agilent Oligonucleotide Array-Based 

CGH for Genomic DNA Analysis (ULS Labeling for Blood, Cells, Tissues or FFPE) Protocol v3.3 

参照ラベル化に用いる DNA の濃度が高すぎる（低すぎる） 

ラベル化に用いる DNA の量は experiment と reference を同じにすることが重要です。DNA に沈澱が生
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じている場合や、DNA 濃度が高すぎる場合、正確に DNA の濃度を測定することが難しくなります。 

また、有機溶媒や RNA などの混入物は、260nm に吸収をもつため、DNA 濃度の正確な測定を困難に

します。 

 

推奨操作 

• ピペッティングにより、ゲノム DNA が完全に溶解していることを確認します。37℃で 30 分間の加熱

も有効です。ゲノム DNA の濃度が 350 ng/μL 以上の場合、Nuclease-free 水などにより２倍に希

釈し、再度測定してください。 

• DNA の精製方法が異なると、異なる定量アーチファクトを生じることがあるため、Experimental と

Reference サンプルが違うソースから精製されている場合にアッセイノイズのリスクが高くなります。

DNA の 濃 度 を ２ 種 類 以 上 の 異 な る 方 法 で 測 定 す る こ と を お 勧 め し ま す 。 例 え ば

Spectrophotometer（例 NanoDrop）で測定している場合は、二本鎖 DNA 検出する蛍光分析法

fluorometer （例 Qubit）でも測定することをお勧めします。 

• 必要に応じて DNA を Qiagen DNeasy プロトコルで再精製してください（p.20~参照）。 

 

◼ Specific activity が低い場合（サンプルの品質には要因がないことが予測される場合） 

Specific activity (p.41 参照)が低い場合、ラベル化反応に要因がある可能性があります。（Cyanine dUTP

の劣化（繰り返し凍結融解など）、酵素の劣化（長時間の室温放置など）、異なった反応温度や時間、容量、

ラベル化の際の過剰な露光 など.） 

 

推奨操作 

• 融解後の Cyanine dUTP は４℃で保存してください。酵素は使用の際は必ず氷上に置き、使用後

は速やかに-20℃に保存してください。 

• 反応温度を再度ご確認ください。 

• ヒートブロックを使用している場合、熱伝導を良くするため、予めチューブをセットする穴に少量の水

を入れてください。 

 

◼ ラベル化 DNA の yield が低い場合（サンプルの品質には要因がないことが予測される場合） 

ラベル化ステップで Random Primer, Exo-Klenow Fragment, dNTP 等が添加されているか確認して下さ

い。 

 

ラベル化 DNA の Clean-up 操作でサンプルが失われている可能性があります。 

 

推奨操作 

• p.39~に示された方法によりラベル化 DNA を Clean-up してください。（推奨以外の精製カラムでは

短い fragment が失われることがあります。） 

• カラム不良の可能性があります。万が一のため clean-up 終了後の UV 測定の結果を確認するま

で、column の through 画分の保存を推奨します。必要に応じて、新しい column を用いて through

画分からの再 clean-up をご検討ください。 
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◼ Signal が低い場合 （ラベル化には問題ない場合） 

洗浄またはハイブリダイゼーションの stringency が高すぎる、もしくは Cyanine 5 シグナルの分解が予想

されます。 

 

Cyanine 5 シグナルの分解は、環境・ラボ内機器などからのオゾンもしくは窒素酸化化合物により起こるこ

とがあります。Cyanine 5 シグナルの分解により、マイクロアレイ feature のふちの red シグナルが低くな

り、Cy5/Cy3 Positive ratios に勾配が生じ、Cy5/Cy3 Negative ratio が増加します。特にスライドの左側ほ

ど、また同時にスキャンしたアレイスライドセットのうちあとにスキャンしたものほど、上記の現象がみられま

す。 

推奨操作 

• ハイブリダイゼーションオーブンの温度が 67℃であることを確認して下さい。必要に応じてハイブリ

ダイゼーションオーブンの校正を実施してください（p.48 参照）。 

• 洗浄 2 の温度が 37℃であることを確認してください。 

• 洗浄１のかわりに間違えて洗浄２が使われていないか確認してください。 

• 低オゾン濃度（＜5ppb）の環境において洗浄・スキャンを行ってください。（例 オゾン除去フィルタ

の採用）。 

• オゾン除去フィルタの採用が難しい場合、Stabilization and Drying Solution を使用する。かつ１度

に処理するスライドの数を少なくし、空気にさらされる時間を極力短くする。（約 40 分以内） 

 

◼ BGNoise が高い場合  

BGNoise が高いと、signal-to-noise 値が低くなり、DLRSD 値が高くなることがあります(p.73 QC metrics

参照)。BGNoise はネガティブコントロールの Background-subtracted シグナルの標準偏差を表していま

す。BGNoise が高い場合は、アレイの TIFF 画像で non-uniformity な現象がみられていないか確認してく

ださい。多くは洗浄操作に起因します。 

 

推奨操作 

• ハイブリダイゼーションオーブンの温度が校正されていることを確認してください（p.48 参照）。 

• 洗浄に用いる器具類（スライドラック・スライド洗浄ガラス容器・回転子・超精密ピンセット）が清潔で

あることを確認してください。水道水で洗浄する場合は、その後水道水が残らないように Milli-Q 

ultrapure water でよくすすいでください。洗浄の際、洗剤を使用しないでください。また必要に応じ

て、アセトニトリルによるリンス後、Milli-Q ultrapure water で十分にすすぎます。（洗浄の方法は

p.58 参照） 

 

◼ 再現性が低い場合  

QC Metrics の Reproducibility 値（p.73 QC metrics 参照）が高いことは、マイクロアレイ上の繰り返しプロ

ーブのシグナルの CV 値が高いことを示し、ハイブリダイゼーションの容量が少なすぎることや、ハイブリダ

イゼーションの際にハイブリダイゼーションオーブンの回転が途中で停止していることが考えられます。この

数値が非常に高い場合、DLRSD に影響します。 
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推奨操作 

• ハイブリダイゼーションチャンバの組み立ての際（p.48）、ハイブリダイゼーション溶液をゆっくり吸う

ように気をつけてください。 

• ハイブリダイゼーションオーブンの回転を確認してください。 

 

◼ SureScan で Initialize logger failed’のエラーが出た場合 

SureScan の場合、スキャンコントロールソフト を立ち上げた際に以下のエラーメッセージが出て、スキャナ

本体と通信できない事がありますが、次の手順でエラーを解消することができます。 

 

1. 上記のエラーメッセージの OK を押します。 

2. スキャンコントロールソフトで Tool > Log files と選択し、ログファイルのフォルダを開きます。 

3. スキャンコントロールソフトを終了し、装置の電源もオフにします（PC の再起動は必要ありません）。 

4. 上記 2 で開いたフォルダ、C:¥ProgramData¥Agilent¥MicroArrayScanner¥Logs の中にある、 

ExceptionLog.txt というファイルをデスクトップなど別のフォルダに移します。 

5. 再度、スキャナ本体の電源をオンにし、スキャナ右上の LED ランプが黄色に点灯し消灯後、スキャンコ 

ントロールソフトを立ち上げてください。 

6. 移動した ExceptionLog.txt は元の場所には戻さず、破棄して下さい（スキャンコントロールを立ち上げ

た際に Log のフォルダには既に新しい ExceptionLog.txt が作成されています）。 

 

C ドライブ中に ProgramData がない場合、ProgramData が隠しファイルになっていますので、下記の方法

で表示ください。 

【Windows 7】 

a) スタートメニューから [Control Panel ] を選択 

b) [ Appearance and Personalization ] を選択 

c) [ Folder Option]を選択 

d) [ Folder Option] ダイアログが表示されるので、[ View ] タブを選択 

e) [ Advanced Settings] の[ Hidden files and folders ]の中で[ Show hidden files, folders, and drives を 

選択し、apply 

【Windows 10】 

a) スタートメニューから Explore を選択、またはスタートメニューを右クリックし File Explore を選択 

b) 現れた Explore ウィンドウで View タブ を選択 

c) File name extensions および Hidden items にチェックを入れる 
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